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LEGAL NOTICE

This document has been prepared for the European Commission however it reflects the views only of
the authors, and the European Commission is not liable for any consequence stemming from the
reuse of this publication. More information on the European Union is available on the Internet
(http://www.europa.eu). The reuse policy of European Commission documents is implemented by the
Commission Decision 2011/833/EU of 12 December 2011 on the reuse of Commission documents (O)J
L 330, 14.12.2011, p. 39).

Except otherwise noted, the reuse of this document is authorised under a Creative Commons
Attribution 4.0 International (CC-BY 4.0) licence (https://creativecommons.org/licenses/by/4.0/). This
means that reuse is allowed provided appropriate credit is given and any changes are indicated. For
any use or reproduction of elements that are not owned by the European Union, permission may need
to be sought directly from the respective rightholders.

LEOS v 5.0.3.
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ABOUT LEOS

LEOS (Legislation Editing Open Software) is an open-source software designed to help those
involved in drafting legislation, which in itself is a complex knowledge-intensive process, by
supporting efficient online collaboration.

More information on LEOS can be found on Joinup and the code repository on code.europa.eu.

EdiT is the European Commission instance of LEOS, an online collaborative tool for drafting
legislation.

EdiT supports the close collaboration between Commission’s services, not only for the drafting
phase, but also for arbitrating and consolidating comments and amendments in the interservice
consultation and in the future, in the adoption phase.

To be noted that some of the features presented in this document are based on the predefined
configuration and templates included in LEOS and they can be changed.

If you have any questions about LEOS or this user manual don’t hesitate to contact us at:

DIGIT-LEOS-FEEDBACK@ec.europa.eu

LEOS v 5.0.3. 5
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LEOS How TO’s

Repository Browser

dil Acceptance

nomel 1 Upload
Filters « 2 Search Upload
Search Q Results 3 Open =
1 proposal found .

Propaosal for a REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL an cross border

1- Filters: tick or untick different boxes

2- Search: allows you to search based on the keywords

3- Open: opening the document/proposal by clicking on it

4- Create: allows you to create proposals

5- Upload: Upload .leg file. Feature only available for support role.

Proposal/Act Viewer

B Jane Doe (Organisation) 1f @
Home..Daaamal
Pro; 1 2 \ 3 [ 4 PEAN PARLIAMENT AND OF THE COUNCIL on cross border

Drafts  Milestones  Collaborators  Details

Cover Page
Explanatory Memorandum
Legal Act .

Financial Statement Add
There is no financial statement in this document

Annexes N
There Is no annex to this document Add Reorde

LEOS v 5.0.3.
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1- Drafts: access to all documents (Cover Page, Explanatory Memorandum, Legal Act,
Financial Statement, Annexes) that are configured on the template for the selected
proposal/act

2- Milestones: create milestone(s) as well as view them and send a copy of a milestone for
contribution of a specific service (Legal Service)

3- Collaborators: add/remove/edit collaborators and configure their roles

4- Details: information and details about the proposal/act

£
EdiT Acceptance Jane Doe (Organisation) Q_J ®
Home > Proposal View
Proposal for a REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL on cross border | actions. |
Download
Drafts  Milestones  Collaborators  Details Export as POF
Export as Legiswrite
Cover Page Share
Explanatory Memorandum
Legal Act ~
Financial Statement

Annexes
There is no annex to this document

acy Staterment | Developed by DIGITA3 | Version: 5.0.2 | Revisior: EGT Drafting | Date: 2024.01.16 12:09 CET

<Actions> button in the Proposal Viewer:

Download the proposal as a .zip file that contains the proposal in .leg format,
functionality available for the users with support role

- Export as PDF: implementation not available in open source release
- Export as LegisWrite / Word: implementation not available in open source release
- Share the link to the proposal/act via email

- Delete the proposal/act (if the user has the Author rights or support role)

LEOS v 5.0.3. 7
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Document Viewer

EdiT Test Jane Doe (Orgasisa
. a
a -
) sty b Bocumant naten
Document Viewer
Proposad fox a
REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCEL
Y by
THE ELROPEAN PARLLAMENT AND THE COUNCEL OF THE ELROPEAN LNION.
ot 3
Ansatations

1- Navigation Pane: Expand and collapse elements and edit document structure inline

2- Versions Pane: see all versions of the document, compare versions, revert to a version,
export a version in XML, and search text in versions

3- Document Viewer: view and edit the document

4- Annotation Pane: comments, suggestions, highlights and document notes

Home > Proposal View > Legal Act v2.0.5 - last edited by Jane Doe (Organisation) on 26/02/2024 14:24

«
See .

B save () Import from Of Exports § Q search e e

Display Track-changes ~

<

Navigation Pane

e Proposal for a

Preface
> Preamble
W Enacting Terms

Article 1 - Scope 1.Text..

Signature

Versions

Article 2 - Definitions Text identified in Article 3,
Article 3 - Entry into force This Regulation shall ...

REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL

test 5.0.3

THE EUROPEAN PARLIAMENT AND THE COUNCIL OF THE EUROPEAN UNION,

Having regard to the Treaty_on the Functioning of the European Union, and in particular
Atticle [..] thereof,

Having regard to the proposal from the European Commission,

Annotations & document notes

Functionalities available in the floating menu:
- Save as a major version.
- Import from the Official Journal of the European Union.

- Export this version to PDF: Implementation of this feature is not available in the open
source release.

- Export this version with annotations to PDF: Implementation of this feature is not
available in the open source release.

- Search and replace in the document.
- See user guidance.

- Enable track changes: enable/disable working with track changes.

LEOS v 5.0.3. 8
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- See track changes: display the track changes or display the text by ‘simulating’ that all
track changes were accepted.

The actions buttons are displayed on top of the screen in the floating menu. The floating
menu is displayed by default when the user goes to review any of the documents from the
Proposal.

Navigation Pane
& @
REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCEL

> fre

st S0

Arnctations & document notes

Versioms >

The user can hide the floating menu using the small icon from the right corner (see

below):
Home > Proposal View > Legal Act 2.0.5 - last edited by Jane Doe (Organisation) on 26/02/2024 14:24
B sove T Import from O p Q Search -
- A
BROWSING

The home page of LEOS is the Repository Browser, with options to search, filter, open and
create documents.

gil Acceptance

Filters + 2 Search pioad

Searct a Results 3  Open sort
Procedures

] o Proposal for a REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL on cross border

O sp

[

u]

a

rets

les.

m]
0 so
O s
] sH
O s
Ao
o
m]

In the general view you will see the list of all proposals/acts you are
author/contributor/reviewer of (for which you have access). There is also the possibility to
search for specific acts by using the search bar. You can search by keywords or by (a part

LEOS v 5.0.3. 9
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of the) title and/or you can use the filters. By default, all filters are unticked, but you can
also tick several of them to get more specific results. No need to press enter, the list is

updated automatically.

Home

Filters Reset €

Search Q

Procedures
[:I Ordinary legislative procedure

D Special legislative procedure
[] Commission legal acts

D Council legal acts

Acts

[] Proposal for a regulation
[ Proposal for a directive

D Proposal for a decision

] Proposal for a Council decision

CREATING PROPOSALS/ACTS AND ADDING METADATA

Creating a Proposal/Act

You can create a proposal/act by clicking on the <Create Proposal> (4) button located at

the top right corner of the global view/repository browser.

jome

Filters Reset <

Search Q Results
1 proposal found

Upload Create Proposal

Sort

A dialog box titled 'Create new legislative document - Template Selection' will appear.
Additional templates will be gradually included in the list. Its purpose is to select a
template for the new proposal/act and provide some information about it like the name,

the EEA relevance, etc.

LEOS v 5.0.3.
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Create new legislative document X
Template selection Document metadata

Select the document type and language

English ~ b

the European Parliament and of the Coundl (withou

Different templates are available in the tree format. There are various controls available
to browse templates:

° On top right, a button is provided to quickly expand the template tree.
° By clicking on arrow buttons, you can selectively browse the tree.

° An input box with title 'Search by document type' is available to filter
templates by name.

The 'language’ drop-down is activated to select the available language for that template.
Clicking on <Next> will navigate to the 'Document metadata' screen.
It consists of pre-populated input fields with the data based on the selected template.

The input field 'Document title' is available for editing to provide the title of the new
proposal/act.

You can also select the EEA relevance option if necessary.

Create new legislative document X
Template selection Document metadata

Enter document metadata

Template 5023 - Proposal for a Regulation of the European Parliament and of the
Coun

Document Title * ©on cross border
Document Language
Confidentiality Level

Internal Reference

Inter-institutional
Reference

Package Title

EEA Relevance

Cancel

LEOS v 5.0.3. 11
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Click <Create> to create the document. The dialog box will be closed, and a new
proposal/act will be created. This new proposal/act will be available in the Repository
Browser.

Upload Proposals/acts

Users with support role can create a proposal/act by uploading an already existing one in a .leg
format.

DOE Jane (i\) (EN]

Home
Filters Reset < Upload Create Proposal
Search Q
Results Sort 4
17 proposal found
Procedures

Opening a Proposal/Act

Once you create a proposal/act, it should be visible in your Repository Browser. The list in
your Repository Browser will be sorted in chronological order, with the most recent act
created or updated on top.

Home

Filters Reset ¢ Upload Create Proposal
Search Q
Results n +
4 proposal found

Procedures

[ ordinary legisiative procedure Proposal for a REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL on cross border

[ special legislative procedure

To open your proposal/act, click on its name. This action will open the Proposal/Act
Viewer (in this case a proposal). If you would like to open any of the documents (Cover
Page, Explanatory Memorandum, Legal Act, Annexes, etc.) of the proposal, click on them.

EdiT Acceptance Jane Doe (Organisation) @ ®
Wome > Proposalview

Proposal for a REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL on cross border

ions § Close

Drafts | Milestones  Collaborators  Details

Cover Page
Doe (Organisation)
Explanatory Memorandum
ane Doe (Organisati
Legal Act ~
ane Doe (Organisai
Financial Statement Add
There is no financial statement in this document
Annexes eorder

Help | Privacy Statement | Developed by DIGITA3 | Version: 5.0.2 | Revision: ETT Drafting | Date: 2024-01-16 12:08 CET

Here in the Proposal Viewer you can see:

LEOS v 5.0.3. 12
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. The type and the title of the proposal (important to know that the title can still
be modified)

. <Actions> button and <Close> button (to close the proposal/act and come
back to the Repository Browser)

Also, you can see the different sections such:
. Drafts of documents
° Milestones of the proposal/act
° Collaborators on the proposal/act
° Details of the proposal/act

The first components in the ‘Drafts’ section are the mandatory ones (Cover Page,
Explanatory Memorandum, Legal Act). All those components are already created based on
the specific template. For the others (Financial Statement and Annexes), if you want to
add information, you need to use the <Add> button.

Closing a Document

To close a document (e.g. Explanatory Memorandum, Legal Act, Annex etc.), you need to
click on <Close> on the top right corner to go back to the Proposal Viewer.

Home > Proposal View > Legal Act v2 \ 26/02/2024 14:24
B sove Import from Of Exports § Q search
«
< <
Navigation Pane

& @ Proposal for a
1 REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL

test 5.0.3

THE EUROPEAN PARLIAMENT AND THE COUNCIL OF THE EUROPEAN UNION

Annotations & document notes

Unigg. and in particular

Versions >

EDITING CONTENT

In the Proposal/Act Viewer, within the ‘Drafts’ section, you can open the documents (e.g.
Cover Page, Explanatory Memorandum, Legal Act, Financial Statement or Annex) you
would like to edit or review.

LEOS v 5.0.3. 13
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EdiT Acceptance Jane Doe (Organisati

Home > Propasal View

Proposal for a REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL on cross border

Drafts | Milestones  Collaborators  Detalls

Cover Page

Explanatory Memorandum

Legal Act ~
Financial Statement Add
There is no financial statement in this document

Annexes

There is no annex to this document

Opening it will lead you to the Document Viewer:

Home > Proposal View > Legal Act v2.0.5 - last edited by Jane Doe (Organisation) on 26/02/2024 14:24
Enable track chang
B save (1) Import from ©) Exports i Q search secusergusance | g sl
See track changes
Display Track-changes ~
< <
Navigation Pane v
o G Proposal fora
Preface REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL

? Preamble
VEnacting Terms
Article 1-Scope 1.Text..
Article 2 - Definitions Text identified in Article 3,..

test 5.0.3

THE EUROPEAN PARLIAMENT AND THE COUNCIL OF THE EUROPEAN UNION,
Article 3 - Entry into force This Regulation shall ..

Annotations & document notes

Signature Having regard to the Treaty_on the Functioning of the European Union. and in particular
Asticle [..] thereof.

5 ‘Having regard to the proposal from the European Commission,
Versions B prop P

To close a document, you need to click on <Close> on the top right corner to go back to
the Proposal Viewer.

Home > Proposal View > Legal Act

B save T Import from O} Exports § Q Search

Navigation Pane v

& @ Proposal for a
Preface REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL
> Preambie

test $.0.3

THE EUROPEAN PARLIAMENT AND THE COUNCIL OF THE EUROPEAN UNION

Annotations & document notes

Signature Having regard to the Trcary on the
Article [...] thereof,

niog of the Fucopean Union. and in particular

A laving regard to the proposal from the European Cor Y
T Having regard to the proposal from the European Commission.

To enlarge a document, you need to use the zoom in option, as shown below:

LEOS v 5.0.3.
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B Save Exports Q Search

Navigation Pane

&
Preface
1. CONTEXT OF THE PROPOSAL
+ Reasons for and objectives of the proposal
« Consistency with existing policy provisions I...
- Consistency with other Union policies
2. LEGAL BASIS, SUBSIDIARITY AND PROPORTIONA
- Legal basis
- Subsidiarity (for non-exclusive competence)
- Proportianality
- Choice of the instrument
3. RESULTS OF EX-POST EVALUATIONS, STAKEHOL...

- Ex-post evaluations/fitness checks of existin

See user guidance

Display

Enable track changes

«
See track changes

Track-changes

EXPLANATORY MEMORANDUM

1 CONTEXT OF THE PROPOSAL

Reasons for and objectives of the proposal
Not Applicable

Consistency with existing policy provisions in the policy arvea
Not Applicable

Consistency with other Union policies

Not Applicable

- ——f§—— +100%

Annotations & document notes

When you drag the control line to the right, the content of the document will enlarge and
if you drag the control line to the left, the content of the document will be reduced

Editing text in the Cover Page

From the ‘Drafts’ section in the Proposal Viewer, click on the Cover Page to open it.

In the Cover Page Viewer, you only have the possibility to edit the title. To do so, hover
over the title and click on the pencil icon or click to edit. Once the title updated, you can
save the modification by clicking outside the element or clicking the <Save and close>

button.

Home > ProposalView > Cover Page

B save Exports § Q search

Navigation Pane

&

Title

Versions >

Contributions 3

v2.0.3 - last edited by Jane Doe (Organisation) on 28/02/2024 19:02

Track-changes

Brussels,

Proposal for a

REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL

test 5.0.3

+100%

Close

A

Annotations & document notes

LEOS v 5.0.3.
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Home > Proposal View > Cover Page

Save Exports }

Navigation Pane v/

&

Title

Versions >

Contributions >

v2.03

Display Trac

last edited by Jane Doe (Organisation) on 28/02/2024 19:02

k-changes

Brussels,

Proposal for a
REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL
a ® x x| Q & B soure

test 5.0.3 1

+100%

Close

A

Annotations & document notes

The updated title will be visible inside the Cover Page, in the title of the Proposal in the

| Developed by DIGIT.A3 | Version: 5.0.3-SNAPSHOT | Revision: EdIT Drafting | Date: 2024-03-06 10:40 CET

Proposal Viewer and also in the Legal Act.

Editing text in the Explanatory Memorandum

In the Explanatory Memorandum, you can only modify the text. To do so, hover over the
text and click on the pencil icon or click to edit. Once the text updated, you can save the

modification by clicking outside the element or clicking the <Save and close> button.

B sove Exports § Q Ssearch

Navigation Pane v

« subsldiarity (for non-exclusive competence)

« Proportionality
« Choice of the instrument
/3. RESULTS OF EX-POST EVALUATIONS, STAKEHOL

« Ex-post evaluations

s checks of existin

Help

LEOS v 5.0.3.

Home > Proposal View > Explanatory Memorandum

See user guidance

Display Track:

v2.0.1 - last edited by Jane Doe (Organisation)  on 26/02/2024 14:24

changes

Not

Not

Not

+100%

Privacy Statement | Developed by DIGIT.A3 | Version: 5.0.3-SNAPSHOT | Revision:

EXPLANATORY MEMORANDUM

CONTEXT OF THE PROPOSAL
Reasons for and objectives of the proposal
Applicable N
Consistency with existing policy provisions in the policy area
Applicable
Consistency with other Union policies

Applicable

EdiT Drafting | Date: 2024-03-06 10:40 CET

Close

A

Annotations & document notes

16
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Navigation Pane v

Home > Proposal View > Explanatory Memorandum v2.0.1 - last edited by Jane Doe (Organisation) n 26/02/2024 14:24 m_

Save Exports } see user guidance

Display Track-changes A

A
A

Not Applicable

Consistency with other Union policies

a ] B I U X xA4&|=: o
B B Q@ I Bsoure

Not Applicable I ©

2. LEGAL BASIS, SUBSIDIARITY AND PROPORTIONALITY

Annotations & document notes

Legal basis

Not Applicable

Subsidiarity (for non-exclusive competence)

Not Applicable

e +100%

Help | Privacy Statement | Developed by DIGIT.A3 | Version: 5.0.3-SNAPSHOT | Revision: EdiT Drafting | Date: 2024-03-06 10:40 CET

Editing text in the Legal Act

When you are scrolling through the Legal Act and the cursor hovers over an editable
element, an action menu icon will appear.

HAS ADOPTED THIS DECISION:

[l

Article 1
Show all acticns

Deduction of holdings of Additional Tier 1 instruments where an institution does not
have a significant investment in a financial sector entity

1.  For the purposes of point (c) of Article 56, institutions shall calculate the applicable
amount to be deducted by multiplying the amount referred to in point (a) of this paragraph by
the factor derived from the calculation referred to in point (b) of this paragraph:

(a) the aggregate amount by which the direct. indirect and svnthetic holdings by the
mstitution of the Common Equity Tier 1, Additional Tier 1 and Tier 2 instruments
of financial sector entities exceeds 10 % of the Common Equity Tier 1 items of
the institution calculated after applving the following:

Clicking on the icon will display the available actions:

does not

The *™ button is for inserting an element before (e.g. an article), the * button for
inserting an element after the selected one (e.g. an article).

The # button is for editing the text of the element, and the O putton is for deleting the
entire element (e.g. an article).
You can edit the text of the element also by clicking once in the element.

The element will open in edition mode:

LEOS v 5.0.3. 17
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Article 1

Deduction of holdings of Additional Tier 1 instruments where an institution does not
have a significant investment in a financial sector entity

1. For the purposes of point (c) of Article 56, institutions shall calculate the applicable
amount to be deducted by multiplving the amount referred to in point (a) of this paragraph by
the factor derived from the calculation referred to in point (b) of this paragraph:

(a)  the aggregate amount by which the direct. indirect and synthetic holdings by the
mstitution of the Common Equity Tier 1, Additional Tier 1 and Tier 2
mstruments of financial sector entities exceeds 10 % of the Common Equity Tier
1 items of the institution calculated after applying the following:

(1) Article 32 to 33;

Note
To navigate quickly from top to bottom, you can use the CTRL + HOME or CRTL + END shortcuts.

You find a short explanation of all buttons available in the editor under Table of buttons.

While editing a section, if you try to go back to the previous screen (by clicking on Previous
in your browser), you need to confirm your choice either to continue and loose the
changes you made or to save first the changes done. The following message would be
displayed:

Changes you made may not be saved. Would you like to proceed?

A warning message would (also) appear if you click on <Close> on the top right corner to
close the Proposal Viewer while still editing:

Open Editor Detected
OF THE EUROPEAN UNI

Unsaved changes will be lost. If you want to continue, press
Confirm. uropean Union, and in paj

Cancel Confirm sion,

LEOS v 5.0.3. 18
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Importing recitals and articles from acts published in the Official Journal of the
European Union

Instead of recycling old acts that are still stored on your network drives, you can import
recitals and articles from previously adopted acts published in the Official Journal of the
European Union?, based on the reference of the act.

Open your document.

On the floating menu click on the <Import from the Official Journal> button.

Home > Proposalview > Legal Act ast edited by Jane Doe (Organisation) on 26/02/2024 14:24
A s 11 import from O] Exports § Q Search
-
< <
Navigation Pane
@
. g
a4 @ Proposal fora s
<
; REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL o
test 803 g
=
g
o
THE EUROPEAN PARLIAMENT AND THE COUNCIL OF THE EUROPEAN UNION, h
@
Versions > Having regard 1o the Treary on the Functioning of the European Union. and in particular 5
st o

Provide the type, the year and the number of the act and click on <Search>.

Import from the Official Journal of the European Union

=

Type * Year * Nr. *

REGULATION v ‘ 2023 v

Select the recitals and/or the articles you need.

Having regard to the proposal of the High Representative of the Union for Foreign Affairs and
Security Policy.

Whereas
—

2| (1) On27 May 2016. the Council adopted Decision (CFSP) 2016/8491

(2) Two natural persons designated in Annex II to Decision (CFSP) 2016/849 are
deceased. and their entries should be removed from that Annex.

(3) Annex II to Decision (CFSP) 2016/849 should therefore be amended accordingly,

HAS ADOPTED THIS DECISION:

Article I

When you are done selecting the elements, click on <Import>.

Element(s) selected: 1

! About EUR-Lex - EUR-Lex (europa.eu)

LEOS v 5.0.3. 19
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The imported recitals and/or articles will be inserted respectively after the last recital
and/or article. You can move them at the place or your choice by using the table of
content.

While LEOS includes the connection to the Official Journal of the European Union, this
may be changed to connect to any other repository, provided all the necessary changes
(e.g. the conversion to AKN4EU) are applied.

The import from the Official Journal of the European Union supports at the moment only
Regulations, Directives and Decisions and in the future implementing and delegated acts.

Creating internal references

When you are editing an article in LEQS, there is the possibility to add internal references
to another part of the document or of an annex.

The internal references are automatically updated if the structure of the document is
updated.

B X h @ I % x & @ Qd

(2) In accordance with the Joint Political Declaration of ZSW of Member
States and the Commission on explanatory documents®. Member States have undertaken
to accompany, in justified cases, the notification of their transposition measures with one
or more documents explaining the relationship between the components of a directive
and the corresponding parts of national transposition instruments. With regard to this
Directive, the legislator considers the of such documents to be justified.

Click on the Internal reference button. A pop-up window with the table of content of your
document appears, and you can select a specific element:

Internal reference x

~-~Having regard to the proposal from the European...
il Article 2

Having regard to the opinion of the European Ec..
Article Test
Having a regard to the opinion of the Commitiee
Acting in accordance with the ordinary legisiat 1 This article
4--Recitals

(1) Recital

(2) In accordance with the Joint Political Decl
+~(3) The Partnership Agreement that was signed b
--(4) In accordance the first subparagraph of Art...
~-(5) Article 95(4) of the ACP-EU Partnership Agr..
4--Enacting Terms

Article 1 - Scope 1.The scope of this article i

Article 2 - Article Test 1.This article

Article 3 - Article heading_.. 1 Article 3

Article 4 - Transposition 1 Member States shall

Article 5 - New article 1 Text.

Article 6 - Entry into force This Directive sha

Selected element{s): article 2

Reference shown as: |Article 2

caneel

Note

When the part of the text you are referring to is being deleted, the link is broken. The system displays it
in red with a red triangle. A tooltip is also shown to inform the user that the reference link is broken.

LEOS v 5.0.3.
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2. The national regulatory authorities shall without delay and by 28 February| of each
calendar vear submit the public list of tariffs
Article 4
Definitions

1. On the basis of the public list of tariffs obtained in accordance with
Urticle 312), point (a) A

Creating / editing the Legislative Financial Statement

How to create a Legislative Financial Statement (LFS)

In the Proposal Viewer, click on the <Add> button in the ‘Financial Statement’ section in
order to add the document legislative financial statement to your proposal/act.

Drafts  Milestones  Collaborators  Details

Explanatory Memorandum

Legal Act

Financial Statement
There

The legislative financial statement will appear in the ‘Financial statement’ section. You'll
be able to add only one legislative financial statement (<Add> button) or remove the one
you've added (<Delete> button).

How to edit the Legislative Financial Statement

By default, the legislative financial statement that you have created contains different
type of elements:

° Read-only elements (non-editable)
° Editable elements

The read-only elements are pre-defined and could not be modified.

Click on one editable element (or select the s icon) to start editing it. The element will
open in ‘edit mode’:

1.4, Objective(s)

s I ERRN B I U x, x* A3
&l

til
™
o)
3
H

1.4.1. General objective(s)

text
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Note

To navigate quickly from top to bottom, you can use the CTRL + HOME or CRTL + END shortcuts.

How to edit a table

A new function was introduced that allows switching from ‘portrait’ to ‘landscape’ mode
to fit the tables width.

You can edit data into the cells of a table.

Click on the table (or select the pencil icon) to start editing it. The table will open in ’edit

mode’.

Heading of multiannual financial

framework

Number

adaa @ « B I Ux ¥4 &/ Q2
m
Enter as many
Years as necessary
YearN . . . to show the
DG:<....... e | YearN+1 | YearN+2 | YemN+3 © TOTAL

duration of the
impact (see point
1.6)

« Operational appropriations

Budget line i

Commitments

(la)

Payments

(2a)

Budget lin

Commitments

(1b)

Click on the cell you would like to edit and add the data. To move to the next cell use the
cursor or the arrow >’ on your keyboard.

When you right click on your mouse, the following menu will display:

(Z

Paste Ctrl+V

Cell

Row

Column
Delete Table

R Table Properties

You can add or delete a row by selecting <Row>, then <Insert Row Before> or <Insert Row
After> or <Delete Rows>. You can add or delete a column by selecting <Column>, then
<Insert Column Before> or <Insert Column After> or <Delete Column>.

B Paste Clri+
Cell

| row Insert Row Before | -
Column | Row Insert Row After
Delete Table Delete Rows

R Table Properties

(& Paste Ctrl+

Cell 4

Row 4

Column 4 Insert Column Before

| Column ‘ nsert Golumn After ||
R Table Properties Delete Columns

LEOS v 5.0.3.
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Edit the text in the cells.

Press the <Save> or <Save and close> icon to keep the changes
outside the ‘editor’.

How to activate and deactivate checkboxes

, or click

Checklists are available in the legislative financial statement. You can activate the
checkbox from the legislative financial statement viewer, by clicking on the checkbox. To

deactivate unclick the checkbox.

1.7. Method(s) of budget implementation ]11=armed2 4
Direct management by the Commission

| by its departments, including by its staff in the Union delegations;
O by the executive agencies
O Shared management with the Member States
0 Indirect management by entrusting budget implementation tasks to:
O third countries or the bodies they have designated;
international organisations and their agencies (to be specified);
the EIB and the European Investment Fund;

bodies referred to in Articles 70 and 71 of the Financial Regulation;

o o o o

public law bodies;

On each activation/ deactivation, the financial statement is saved automatically.

Note

Activate checkboxes outside the ‘editor’, update the text of the legislative financial statement inside the

‘

editor’.

How to use a date picker

You can add a date or a year by using the ‘date picker’ option.

To add a date, click on the icon :l .

1.6. Duration and financial impact of the proposal/initiative

O limited duration

O ineffect from [DD/MM]YYYY| . |fo [DD/MMIYYYY] |

O Financial impact from YYYYl:I to YYYYE for commitment
appropriations and from YYY‘:D to YYY‘:D for payment
appropriations.

O  unlimited duration
Implementation with a start-up period from YY YY\:\ oYY YY\:\.

followed by full-scale operation.

LEOS v 5.0.3.
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A pop up will display with the calendar. Select the month, the year and the exact day. The

selection will be automatically saved. To add a year, click on the icon El and select the

year (1). By clicking on any day (2) in the calendar, the year will be selected and
automatically saved.

0 Jun v 2023 | @@
Su Mo Tu We Th Fr Sa
(2] 1 2| s

P

1" 12| 13 14| 15 16| 17
18 19| 20 21| 22| 23| 24
25| 26| 27 28 29| 30

Reset

Creating / editing an annex
How to create an annex

In the Proposal/Act Viewer, click on the <Add> button in the ‘Annexes’ section in order to
add the component annex to your document.

Annex title Last Updated by Last Updated on Actions

Submission form

Jane Doe (Organisation) 6/11/2023 13:43

The annex will appear in the ‘Annexes’ section. You'll be able to add more annexes (<Add>
button) or remove the ones you've added (kebab menu).

You can also add a specific title by clicking on <Change title>, typing the title and clicking
on <Save> to confirm. To open your annex, click on the annex.

Edit title X

Title | Submission form

Can[el

Also, by clicking on <Reorder>, you can reorder annexes by dragging and dropping items
from the list. The annexes are automatically renumbered.

Annexes

Annex title Last Updated by Last Updated on Actions

Submission form Jane Doe (Organisation)

Annex Jane Doe (Organisation)

LEOS v 5.0.3. 24
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Edit annex order X

You can reorder annexes by dragging and dropping items from the list

= Submission form

= Annex

Close

How to edit the annex

By default, the annex that you have created will be level based.

ANNEX
1. Text...
1.1. Text...
2. Text...

Click on one element to start editing it.

ANNEX
1. Text...
1.1. Text...
a@EAa ] B I x x* 4| a' B Z Q G A e
=l
ll‘ Text... ®

Creating internal references

To create an internal reference, please check the section Creating internal references.

How to add an image in the annexes

You can select the image icon to add an image in the Annex(es) of the proposal.

(s I | ] B I x x 4| a B Q@ m| =
1.1. Text...
| (1
2. Text...

LEOS v 5.0.3.
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Once the icon is selected, the following pop-up window appears where you can choose to
upload an image (clicking on <Choose File>) or propose an alternative text (typing some
text in the Alternative Text area).

Image

Alternative Text

Choose File | Mo file chosen

Width Height
Lock Ratie

How to switch the annex structure to an article structure

You can change it to an article-based annex by clicking on the <Change Annex Structure>
button in the floating menu.

]

> ! ? Annex vl ot edeed by Jane Doe (Organisation)
[ B Espons | Q Seanch — B Crange Aves Structure
« - targ
pl - o s ~
. <
Nawigation Pane .
4L @ Anmex 3
Pretace E
Voely 1 Text 3
F-‘1 L1 Text &
-
- Text §
g
Versions >

Be aware that this action will delete any content that would be currently present in the
annex.

Switch Annex Structure

You are about to change the Annex structure into one based on Article.
This action will delete all content that may already exists in Annex
Are you sure you want to switch current structure to the Article type?

Cancel Confirm

LEOS v 5.0.3. 26
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Annex

Submission form

Article I
Article 1 heading

1. Text.

How to change the structure inside the elements

From the Annex Viewer, add a point by hovering over an existing point and, for example,

click the button * toinsert a point after.

Annex

Submission form

1. Text...

1.1 Text...

111 Text -

12. Text... ol
o

2 Text... -

Then click on the icon # for editing the text in the new point inserted.

-

Select the <Increase indent>icon ~ for increasing the indent of the new point inserted.
The system will automatically increase the number of the level.
Annex
Submission form
1 Text.
11 Text
111 Text
12. Text.
L) [E] B I x x4 Flad B £ Q L BB
=0
13. Text..|
2 Text.

(s N+

Press the <Save> or <Save and close> icon to keep the changes

(After save

and close, you can go back to this point if you need to increase/decrease the indent
again). It is also possible to decrease the indent of a point by using the <Decrease indent>

icon.

LEOS v 5.0.3.
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Annex
Submission form
1 Text...
11 Text...
111 Text

12 Text

aaa [ERRN B I xx&HT 00w *

=0 Decrease Indent

121 Text..|

Editing the table of contents

When you are in a document, to the left of the screen you have the 'Navigation pane’. This
pane will allow you to navigate your document and add/move some structural elements
(e.g. articles & higher divisions).

Under the Navigation Pane you have the <Expand> (1) and the <Edit document structure
inline> (2) buttons. The <Edit document structure inline> (2) is accessible only in the
Legal Act and Annexes.

Home > ProposalView > Legal Act

Proposal for a REGULATION OF THE EUROPEA
<

Navigation Pane| v

m | =
Preface
» Preamble
“ Enacting Terms
Chapter 1 General provisions
Article 1 - Definitions Text...
Article 2 - Entry into force This Regulation shall ...
Signature

Clicking on <Edit document structure inline> (2) will open the navigation pane in edition
mode (the icon will be replaced with an ‘X’ button).

You can now:

- Move already present elements in the tree view by dragging and dropping
them.

- Add new elements by dragging them from the right part into the tree view.
- Delete elements from the three dots menu.

- For the articles, once you drag & drop them in the structure, you have the
possibility to choose the type of article.
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Make sure to press the <Save> or <Save and close> icon on the top right to keep the
changes.

Proposal for a REGULATION OF THE EUROPEAN PARLIAME
<

Elements

.Ret\ta\
M X -
Preface

> Preamble e
v Enacting Terms
Chapter 1 General provisions i
Article 1 - Definitions Text... 3 -

Article

Navigation Pane v

Article 2 - Entry into force This Regulation ...

Signature

Navigation Pane

PR
Having regard to the Treaty on the Fu...
Having regard to the proposal from th... H
After transmission of the draft legislat...
Having regard to the opinion of the E...
Having regard to the opinion of the C...
Acting in accordance with the ordinar...
“ Recitals &
(1) It is necessary to strengthen the de...
(2) Member States and the Union hav...
(3) The new governance structure sho...
(4) It is in the interest of a coherent ap...
(3) When public administrations decid... :
(6) It is necessary to provide a legal ba...

“ Enacting Terms

v Chapter 1 - General provisions

Article 1 - Scope This Regulation lays d... H

“ Enacting Terms

v Chapter 1 - General provisions &

Article 1 - Scope This Regulation lays d... H

Article 2 - Definitions 1.For the purpos...

“ Chapter 2 - Solution

Article 3 - Supervisory powers For the ... Move

Article 4 - Derogation to the applicatio... Delata

Article 5 - Derogation to the applicatio...
Change Type *
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Move
Navigation Pane

Delete )
P
v Chapter 2 - Solution ¢ Change Type »

— —
: Chapter  Definition

Article 4 - Derogation to the applicati... g
Section

Article 5 - Derogation to the applicati... E
Article

Article 6 - Application of stricter requ...

Article 3 - Supervisory powers For th...

If you select Regular, it would be up to you to fill in the Heading.

If you select Definition, the heading would be filled in automatically with ‘Definition’: For
both (Regular and Definition), the numbering will be added automatically.

A regular article contains up to 4 levels of indentation, a definition article contains up to 3
levels of indentation. If you try to convert a regular article with more than 3 levels into a
definition article (by changing the type), the system will display the following message:

Conversion not allowed!

Not allowed to convert article to DEFINITION, because the current depth of 4 is exceeding the
maximum allowed depth level of 3.

Close

Using the Search and Replace function

In the floating menu, click on the <Search> button. Then type the word you would like to
find back in the text, e.g. ‘Regulation’.

Home > Proposal View > Legal Act v2.0.5 - last edited by Jane Doe (Organisation) on 26/02/2024 14:24 Close
B sove I} Import from O Exports Q Search ‘
< <

Navigation Pane v

The system will highlight all the corresponding words in the text, and you can use the

arrows to move to the next or the previous one '~ [©
Home  Proposal View  Legal Act 2.0.5 - last edited by Jane Doe (Organisation)  on 26/02/2024 14:24
Save ] Import from 0] Exports Q Ssearch e 8 ‘
Display Track-change
< <
Search Q | |v||A|[] MatchCase [] WholeWords | «*

Navigation Pane

LEOS v 5.0.3. 30



LEOS — User Manual

If you tick <Match case>, the system will only highlight the word ‘Regulation’ if the first
letter is in uppercase.

Ticking the option <Whole words> will make sure words like ‘Regulating” will not be
highlighted if you have searched for ‘Regulation’.

You can also choose to find and replace certain words. In this case you'll need to activate

the <Replace> button

Home  ProposalView  Legal Act v2.05 - last edited by Jane Doe (Organisation)  on 26/02/2024 14:24 Close

Exports § Q search

See user guidance

Save T1 Import from O

Display Track-changes

~
N

search | Regulatior| ; @

Navigation Pane

Preface

nt notes

You can fill in the word you would like to replace ‘regulation’ with, e.g. ‘Name’ in this case.
Then click on <Replace>, to replace only the selected word, or <Replace all> to replace all
these words throughout the text.

Make sure to click on <Save> (to save and stay in the find and replace mode) or <Save and
close> (to save and close the find and replace mode).

After this, the replace will become visible.

Home  Proposal View  Legal Act v2.0.5 - last edited by Jane Doe (Organisaion)  on 26/02/2024 14:24 Close
Save [T Import from O Exports } Q search e IReT )
Disp
< <
1 of
Search | Regulation 6 v || A [[[] Match Case [] Whole Words |
Navlganon Pane Vv
Preface

Recital...

S

(2) Recital.. udshilkfblksdfgnsds
tified in Article 3,...
Regulation sha (3) The G-20 Declaration of 2 April 2009 on Strengthening of the Financial System called
Sienature for intermationally consistent efforts that are aimed at strengthening transparency,
B accountability and fegulation by improving the quantity and quality of capital in the
‘banking system once the economic recovery is assured. That declaration also called for
introduction of a supplementary non-risk based measure to contain the build-up of
leverage in the banking system, and the development of a framework for stronger
liguidity buffers. In response to the mandate given by the G-20, in September 2009 the
Group of Central Bank Governors and Heads of Supervision (GHOS), agreed on a
Contributions > number of measures to strengthen the ios of the banking sector. Those measures
were endorsed bv the G-20 leaders at their Pittsburgh Summit of 24.25 Sentember 2009

Versions >

Annotations & document notes

Using the Drafter's Assistance Package (DAP)

In LEOS, you can find as example for an assistance package, links to the Drafter's
Assistance Package which was designed to help Commission drafters produce draft legal
acts. It contains guidance on drafting legal acts of the Union. The Drafter's Assistance
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Package was drafted by the Commission’s Legal Service? and its use is only for European

Commission.

In the floating menu, check <See user guidance>:

—
Home  Proposal View  Legal Act 5 - last edited by Jane Doe (Organisation)  on 26/02/2024 14:24
| |
Save 1) Import from O} Exports § Q search See ce
| Displa: ‘
< <
Navigation Pane v -
2
& @ Proposal for a g

Guidance information and links to DAP will be displayed in your document:

REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL

test

EARLIAMENT AND THE COUNCIL OF THE EUROPEAN UNION,

Having regard to the Treatv on the Functionins of the European Uniog, and in particular
Asticle [...] thereof,

Having regard to the proposal from the European Commission.
After transmission of the draft legislative act to the sational Parliaments,

Having regard to the opinion of the European Economic and Social Committee!, test

Haviag regard to the opision of the Committee of the Regioas®
[where necessary

Acting in accordance with the ordinary legislative procedure,

Whereas

(2) Recital..

HAVE ADOPTED THIS REGULATION:

Article 1

Scope
[DAP info] Scope

1. Text.

Article 2

Definitions
[DAP info] Definitions

Text...

Article 3
Entry into force

[This Regulation shall enter into force on the [...] day following that of its publication in the
Official Journal of the European Union.

This Regulation shall be binding in its entirety and directly applicable in all Member States.

[Choose between the two options above. The second option must be used where the
Regulation is binding and directly applicable only in certain Member States in accordance
with the Treaties.]

Table of buttons

A short explanation of all buttons in the editor:

Button Explanation

Location/availability

Save, Save and close or Close without saving

All documents

¥ [y (g |Cut, Copy and Paste

All documents

- Undo, Redo

All documents

Bold and italic

EM, LA, FS, A

Underline button

EM, FS

Subscript and superscript

n
x
u

All documents

Fg-
cut >

Change upper case to lower case and vice versa

EM, LA, FS, A

2 Legal Service - European Commission (europa.eu)

LEOS v 5.0.3.
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Button Explanation Location/availability
Soft enter (start a new unnumbered line (subparagraph or |LA, FS, A
subpoint), but not a new paragraph (this would be
numbered))
— Add subparagraph (add a new unnumbered line, but directly to |LA, FS, A
-~ the first level of numbering (1., 2., 3., etc.); the paragraphs
= Paragraph mode (activate or deactivate numbering) ) LA
Insert/Remove Numbered List EM
1= ]
=  e=
Insert/Remove Bulleted List
Je GE Decrease or increase indent EM, LA, SF, A
at Insert footnote EM, LA, FS, A
= = Center/Justify the text EM
Insert an internal reference LA, A
Add a mathematical formula: LA, FS, A
Mathematics in TeX »
Write your TeX here
% = {-b \pm \sgrt{b*2-4ac} \over 2a}
=
E— —
_ bt/ —dac
L= 2a
m Cancel
is Add a table: EM, LA, SF, A

LEOS v 5.0.3.
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Button Explanation Location/availability
Table Properties x
Rows
Columns
2
Headers
Mone w
Add a special character (e.g arrows, checkboxes, radio button [CP, EM, LA, SF
etc.):
Select Special Character W
|I|' # 5 W & - a1 2
i1 4 B B 7 B2 9 o= = = 7 @ A B G
D E F G H I 4 KL MmH~NOOPZHR S T
u v w x ¥ I | _ B boc d & 1
g h ! 1 m n o p q 5 u ¥ W
Q ¥ o2 £ - — [
¥ 5 e * @ T |
N R LA A A A A E C
E E E i I 18 R & 4 d o a
U0 0 U Y¥Y o B a & & 8 8 & ® & &
-] & A & o & 0 0 - @B ©W @
[T i t FE @ WY W ' ™
—_ = "= O F &
Cancel
Ed Image -add image EM, SF
0 Show blocks (will make the different levels visible, see picture |CP, LA, SF, A
= below)
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Button Explanation

Location/availability

Institutions shall exclu
amount referred to mn |
to in point (b) of parag

The amount to
Additional Tier
Tier 1 instrum
amount specifie
of this paragrap

the
Toggle track changes display LA
Abbreviations:
CpP Cover Page
EM Explanatory Memorandum
LA Legal Act
FS Financial Statement
A Annexes
REVIEWING

In the Proposal/Act Viewer, within the section ‘Drafts’, you can open the document you
would like to review/comment on. Once you've opened it, you will be in the Document
Viewer. In the right part of the screen, details on comments and suggestions will be

visible.

You can add annotations, in line with the type of areas (and the type of the document):

° editable area: you can add comments, suggestions and highlights.

. non-editable area: you can add comments or highlights only.

LEOS v 5.0.3.
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Home > Proposal View > Legal Act

T! Import from Of

B soe

Navigation Pane

Versions >

Exports

5 - last edted by Jane Doe (Organisation) 26/02/2024 14:24

Q search See use | o
Display T
Annotations & document notes
©
Proposal for a .
REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL - @
8

test 5.0.3 leana

2 EUROPEAN PARLIAMENT AND THE COUNCIL OF THE EUROPEAN UNION

ing regard to the Treaty on the Functionine of the Evropean Uniop. and in partic

cle [...) thereof, ~
"ing regard to the proposal from the European Commission,

2r transmission of the draft legislative act to the national Parhaments,

G >V

Add a comment/suggestion/highlight/document note

How to add a comment

As an author, contributor or reviewer you can add comments to the text.

From the proposal/act viewer, open the document you want to comment on.

Select the part of the text you would like to comment on.

Click on the <Comment> button.

nsistency wit olicy provisio
e [@ | ¢ 0
Comment | Suggest  Highlight

Type the comment in the box that will appear on the right side of the text. You can write

with bold and italic, insert special characters and add links while adding comments.

LEOS v 5.0.3.

[ 16:31
BlI Qe

‘ Insert Special Character

to be completed

4+ Collaborators

Postto Collaborators v JOEeENST

Jane Doe (Organisation) (23111723, 16:00)

Article 24
B Il

For more information: https://eur-lex europa.eu/oi/direct-

access html

%2 Collaborators

Post to Collaborators v EOReEnE
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Fill in the URL field with the hyperlink.

Link X

Display Text

m o

Post the comment. You will have several options on who it will be visible to (e.g. if you
post to your group/organisation only the collaborators that belong to that
group/organisation will be able to see the comment).

A highlight will be visible in the text, linked to the comment, name and date/time on the

right.
Jane Doe (Organisation) 22/11/23, 16:06)
without delay and by 28 February of each 2 28 February
Are you sure about this date?
When clicking on the button <Show/Hide Guide Lines> / you can make the line

connecting highlight and comment visible or not.

E How to get started

B 1 7o creste s comment select text 2 . @\

larcel tariff

with Article 5(1), point (b)

Annotations2  Document Notes

22 Collaborators

m Reject (JMark as processe:

Jane Doe (Organisation)
and by [28 February of each 28 February
Are you sure about this date?

How to add a suggestion
As an author, contributor or reviewer you can add suggestions to the text.
From the proposal/act viewer, open the document you want to add suggestions to.
Select the part of the text you would like to make a suggestion on.

Click on the <Suggest> button.
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ocated to the Member State refery
il to therein for PN shall be deen

P—
(&x| L] A
Comment J Suggestl] Highlight
Arficie 3

Edit the selected text in the box that will appear on the right side of the text. You can type
your text and add special characters if needed.

Q

more efficient]

L]

Post to Collaborators | v JORe=RTE

Q

maore efficient

Q This sentence does not start
with an uppercase letter.

More
¥
® Ignore all
R — -

Post to Collaborators | v EONeEnl

You will also have the possibility to add a justification if needed.

v Add justification

B I Q=

2 (Collaborators

Post to Collaborators | v RGNeEl=

Post the suggestion. You will have several options on who it will be visible to if you click on
the dropdown list.

A highlight will be visible in the text, linked to the suggestion, name and date/time on the

right.
Jane Doe (Organisation) (22/11/23, 16:07)
better
br better cross-border parcel delivery wettermore efficent
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0o

When clicking on the button <Show/Hide Guide Lines>
connecting highlight and suggestion visible or not.

/

you can make the line

[{Tegislative act to the national Parhaments,
lof the European Economic and Social Committee!

ordinary legislative procedure.

ross-border parcels
lational segulatory authority of information >

ULATION:
Chapter 1
General provisions
Article 1

Scope

specific provisions to foster better cross-border parcel delivery

Article 2

Definitions

D How to get started

2

annatations

Annotations 3 Document Notes

2

In order to view the justification, you will need to click on <Show justification>.

procedure
procedure

> Show justification
> I.Jxod feedback

% (ollaborators

Jane Doe (Organisation)

(28/11/23,13:17)

m Reject (O Mark as processed

AR

Select the suggestion(s) you want to act on and use the action buttons on top. Possible
actions have in grouped in one button. You can use it to Accept, Reject, Mark as

processed...:

1

\

3

Click on
annotation to
select several
or

1 annotation selected

selected
annotations
Reject
Annotations 6
Delete
Jane D Mark as processed
troduction

troduction of

L Collaborators

m Reject (J Mark as processed

How to add/remove a highlight

As an author, contributor or reviewer you can highlight certain parts of the text.

LEOS v 5.0.3.
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From the proposal/act viewer, open the document you want to add highlights to.
Select the part of the text you would like to highlight.
Click on the <Highlight> button.

Regulation by vessels flying
shall be [glitidizs | from the
1_( . - 1 1 1 -

t @ 8

Highlight

A highlight will be visible in the text, linked to the name and date/time on the right
Highlights are only visible to you, not to other users.

PT TITE UTALT [EZTSTNVE aCt [0 UIE TETOTEl Pl [TaTenn

Jane Doe (Organisation)
ofthe European Economic and Social Commitree{ opinion

e with the ordinary legislative procedure,

8 Onlyme £

There is the option to hide the highlighted text via the <Eye> button, as per the
screenshot below, which is available when expanding the annotation window.

AND OF THE COUNCIL

s 11/23

E Actions on selected ‘
'HE EUROPEAN UNION. annatations

Highlights can be treated as normal annotations, as they appear in the right margin. You
can select / deselect one or multiple highlights and delete them.

How to add a document note

As an author, contributor or reviewer you can add general document notes which refer to
the document as a whole.

From the proposal/act viewer, open the document you want to add a note to.

O

=]
g = |

Click on the <New document note> button in the Annotation pane E .

Type the document note in the box that will appear on the right side of the text.

LEOS v 5.0.3.
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se |

F THE EUROPEAN UNION, annotations
uropean Union, and in particular Annotations 4 Fo:ument Notes 1 I

1

Jane Doe (Organisation) (23/11/23, 16:18)
on,
BI Q =
Parliaments,
H Social Committeel, 1
2 Collaborators
| ® Cancel

Post the document note. You will have several options on who it will be visible to (e.g if
you post to your group/organisation only the collaborators that belong to that
group/organisation will be able to see the comment).

The document note will be visible in the Annotation pane, when you click on the
<Document Notes> tab.

Amrieatteriey Fo;umom Notes ! I

Jane Doe (Organisation)

BI Q)=

Reviewing comments

As an author or a contributor, you can review the comments that were added to the text
by other authors, contributors or reviewers.

From the Act/Proposal viewer, open the document you want to edit.

Look for comments from the co-author, contributor or reviewer. Name, department and
time of creation will be visible.

With the dustbin icon, you can decide to delete the comment.

Jane Doe (Organisation) T2, 1607)

28 February of cach

Jane Doe (Organisation) (22111123, 16:06)

= about this date?

Are yo
> Add feedback

f its publication in the ’E .
2 Collaborators

11 Member St (O Mark as processed
in all Member States. b

Before the deletion, the system asks you to confirm:

says

Are you sure you want to delete this annotation?

“ Cancel
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With the reply icon, it's possible to reply to the comment made by the other party. A

textbox appears.

Jane Doe (Organisation)
28 February

Are you sure about this date

> Add feedback

L Collaborators

=

With the forward icon, you can forward your comment to your colleagues.

28 February of each

(22/11/23, 16:06)

Jane Doe (Organisation)

28 February

Are you sure about this date?
> Add feedback

%2 Collaborators

(J Mark as processed

With the feedback feature, you can include feedback about how the comment is
processed and mark the comment as processed (useful when consolidating the comments
and suggestions of the consulted DGs during the interservice consultation; your feedback

will be visible to the consulted DGs i

n Decide Consultation module).

28 Febmuary of each

Jane Doe (Organisation)

ar

Are you sure about this date?

> Add feedback

(O Mark as processed

(AAE) (22/11/23, 16:06)

Note

che

ndeed, the date needs to be

m ® Cancel A

I O =

chied

In case you try to exit your feedback/comment/reply before clicking on Post, you will get a warning:

forward your comment to:

LEOS v 5.0.3.
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8 DIGIT
L DIGITE

L DIGITEZ2

L DIGITB2.007 o

iﬁ e

Then click on Post to ‘the name of the users group’ to forward the comment:

B I Q=

Should we add Scope and
definitions here?

o

2 DIGITAZ
Post to DIGITA.3 | v [SBESELEE

After this, the replies will be visible by clicking on the dropdown list.

Jane Doe (Organisation) (0:
paragraph 1
are you sure its par 1?

Show replies (1)

Once you have reviewed a comment, you have the possibility to mark it as processed.
Select the comment and click on <Mark as processed>:

Annotations ¢ Document Notes

Regulation shall enter (Show more) |
Please move this article at the end

22 Collaborators

(0 Mark as processed

You will be asked to confirm:

Are you sure you want to mark as processed?

¢ ance' '9l

Then, when you come back later to your document to review the annotations, it will be
easier to see what you have not reviewed yet.
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In the annotations panel on the right, by default the annotations marked as processed are
not visible (non-processed selected in the filter).

oy

If you need to see all annotations again (processed and not processed), you could select
<By status = all>.

Then, the annotations which have already been processed would appear in grey:

Jane Doe (Organisation) (24111423, 11:38)

New comment

new comment

4 Collaborators

Jane Doe (Crganisafion) (22/11/23, 16:06)
28 February
Are you sure about this date?

% Collaborators

You also have the possibility to edit someone else comments (if you have the author role
and if the comments were drafted in LEOS). Hover over the comment and click on the pen
icon to edit the comment:

Jane Doe (Organisation) (09/01/23, )

Having regard to the opinion of t 11:17

To be updated

22 Collaborators

() Mark as processed

Reviewing suggestions

As an author or contributor, you can review the suggestions that were added to the text
by other authors, contributors or reviewers.

From the Act/Proposal viewer, open the document you want to edit.
Look for suggestions from the co-author, contributor or reviewer.

Under the suggestion you can include a feedback about how the suggestion is processed,
accept, reject or mark the suggestion as processed.
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7

brovisions to foster befter cross-border parcel delivery T Jane Doe (Organisation)  (22/11/23, 16:07)

~—_] | better

1 Bettermore efficient

Article 2 v Add feedback

Definitions B I O

Jane Doe (Organisation)

Article 3
\rticle heading...
P
% Collaborators
Article 4 I8 reiect OMark as processed

Under the suggestion you will see an <Accept> and a <Reject> button.

To accept the suggested change, click on <Accept>.

Jane Doe (Organisation) 22/11/23,16:07)
better
Eestermore efficient

> Add feedback

% Collaborators

JY2 Ml Reject (] Mark as processed

At the top right, you will see a message to confirm the suggestion was accepted and

merged into the text.

If you don't agree you can also decide to remove a suggestion. Click on <Reject>.

Jane Doe (Organisation) (22/11/23, 16:07)
better

bettermore efficient

> Add feedback

% Collaborators

m ] Mark as processed

A pop-up message will appear, asking you to confirm the rejection.

Are you sure you want to reject this suggestion?

e

Be careful: after this action there will no longer be a trace of the rejected suggestion.

You can also mark this suggestion as processed by clicking on <Mark as processed>.
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Jane Doe (Organisation)

belter

(22111/23, 16:07)

Bettermore efficient

» Add feedback

. Are you sure you want to mark as processed?

i cance‘

< proposal from the European Commission,

H

The suggestion will appear as greyed-out and will still be visible if you filter on Processed
annotations later.

If you feel like the changes proposed need to be discussed or are not clear enough, you
also have the option to reply to a suggestion.

Jane Doe (Organisation) (22/11/23, 16:07)

Bsettermore efficient

> Add feedback

/‘ﬁ
12 Collaborators
m Reject []Mark as processed

When clicking on the reply icon, it's possible to reply to the suggestion made by the other
party.

You can type your response there:

Jane Doe (Organisation) (24/11/23, 10:31)

BI | Q &

| think that we can keep 'better’

m @ Cancel

Click on <Post> to share your response.

After this, the replies will be visible by clicking on the dropdown list.

Jane Doe (Organisati

Hide reply MF‘&JE:H_‘-“—-— ocesse

Jane Doe (Organisati (24711723, 10:42
think that we can keep "better’

You can also forward a response visible to only a group of collaborators. To do so, select
the right arrow:
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Jane Doe (Organisatio

pettermore efficient
Jane Doe (Organisation)
ack

Hide reply (1) m Reject [ Mark as processed

Jane Doe (Organisati

n) (24/11/23,10:42)
i think that we can keep ‘better'

Type your message and click on the dropdown list close to <Post to Collaborators>.

BE I Q|=

What do you think?

©

D@ Cancel

Select a specific list of recipients for your message:

2 Collaborators

| think that we can keep ‘Detter’
3 AAE
4 AGRI
4 BUDG
s CJEU
s CLIMA -
B @ Cancel

Then click on Post to ‘the name of the users group’ to forward the suggestion to this users
group.

Note

If you click outside the box of your suggestion or feedback before clicking on <Post>/<Post to
collaborators>, you will get a warning message:

B I |Q| =

What do you think?

2 56
Postto5G v EONeELIE] A

(De)selecting all annotations

On top of the pane, you'll see the buttons <Select all> and <Deselect all>.
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= Q5

. Click on annotation to m

E Actions

annotations

Annotations5  Document Notes

Jane Doe (Organisation) (23/11/23,16:10)
Article 24

Press <Select all>.

Now all annotations in the documents are selected at once and can be accepted, rejected
or deleted at once.

To accept all annotations in one go, click <Accept>. As comments cannot be accepted, the
system will only select the suggestions!

A window will appear.

Are you sure you want to accept the 2 selected suggestions?

Cancel

To confirm, click <OK>.

A message will pop up confirming the action.

To remove the remaining comments in the document, repeat the previous steps.

Press <Select all>.

Select m Deselect all 2 annotations selected

Actions over selected

annotations

To remove all remaining comments in one go, click <Delete> (as neither <Accept> nor
<Reject> are not options for comments).

A window will appear.

Are you sure you want to delete the 2 selected deletable annotations?

Cancel

Click <OK>.

A message will pop up confirming the action.
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After this the Annotation pane will be empty.

There are no annotations in this group.

Create one by selecting some text and clicking the B button.

Orphan annotations

When you make some modifications on a text annotated with comments (add or delete
words), the comment remains intact.

€T thew general teims and condions | AcceRt e

2 The national regulatory authorities shall without delay and by 28 Febmary of each P
calendar year submif the public list of tariffs. e COMMERE. "

Arricie 5

Definitions 8

Aricie 6

Entry into force

This Regulation shall enter into force on the [...] day following that of its publication in the
Official Journal of the European Union.

This Regulation shall be binding in its entirety and directly applicable i all Member States.

However, if you delete the whole part of the text that was annotated, then the comment
goes under the ‘orphans’ tab.

@ the name, ]tgaL status and form Annotations 3 Document Notes | O

(b) the characteristics
Jane Doe (Organisa:

(¢) their general terms and conditions
2. The national regulatory authorities sh v and by 28 February of each
calendar year submit the public list of tariffs

Article 5

Definitions

Text Jane Doe (Organisa:

Contrastingly, suggestions go always under the ‘orphan’ tab if ANY change on the text
occurs. i.e. add or delete text, the suggestion always goes under the ‘orphans’ tab.

Working with track change

Changes in the text

Track changes
The user reviews the text of a document of the act.

. Collection and use of expertise

The Commission used its own resources to perform the stakeholders’ consultation. The
Security Directorate of DG HR has done the related work on the surveys. videoconferences
and other workshops. This task involved both the selection of participants and the
organisation of events and the processing of the input received.

The Joint Research Center (JRC) performed a risk assessment of the main information
security assets. used as a basis for the Impact analysis.
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In order to edit the text, the user clicks one time inside the editable box.

. Collection and use of expertise

[ (= B I U x. x %3
E M Q& S| Msource  BY-

The Commission used its own resources to perform the stakeholders’ consultation. The
Security Directorate of DG HR has done the related work on the surveys, videoconferences
and other workshops. This task involved both the selection of participants and the
organisation of events and the processing of the input received.

The Joint Research Center (JRC) performed a risk assessment of the main information
security assets, used as a basis for the Impact analysis|

The user edits the text.

. Collection and use of expertise

[ | B « B I U x x % ;= = 7

.= ab
M Q G| L) B source | B3~

The Commission used its own resources to perform the stakeholders’ consultation. The
Security Directorate of DG HR has done the related work on the surveys.

and other workshops. This task involved both the selection of participants
and the organisation of events and the processing of the input recerved.

The Joint Research Center (JRC) performed a risk assessment of the main information
security assets, used as a basis for the Impact analysis.

The user moves outside the box and the text is automatically saved. The system assigns a
colour for the text added/modified/removed by the user (this colour is kept for the same
user across all documents of the same proposal). When hoovering on the respective text,
the name of the user who made the change is shown, together with the timestamp.
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. Collection and use of expertise

The Commission used its own resources to perform the stakeholders® consultation. The =
Security Directorate of DG HR has done the related work on the surveys, videoconferences
teleconferences and other workshops. This task involved both the selectio Jane Doe

and the organisation of events and the processing of the input received.

The Joint Research Center (JRC) performed a risk assessment of the main information
security assets. used as a basis for the Impact analysis.

: 2024-02-08711:03:03+01:

Make changes over track changes
The user edits the text changed by another author/collaborator.

LEOS v 5.0.3.

AsticieSArticle 8

Principles of information-sssurance data

1. The of the in security needs shall be taken into account from the
start of the or at the p stage as regards all CISs including in-house,
outsourced and hybnid CISs,

2. Any CIS that handles and stores EUCI shall be dited-defined in d

with Chapter 5, Section 3. Any CIS that handles and stores sensitive non-classified
information shall comply with the minimum requirements for senmsitive non-
classified information in CISs set out in Chapter 4.

Thematic sub-groups data

1. The Coordination Group shall set up the following permanent thematic sub-groups
to facilitate the implementation of this Regulation:

(a)  asub-group on information assurance;

(®)  asub-group on global physical security;

() 2 sub-group on ECUI& ation systems
handling and storing EUCI;
£&3(1) a sub-group on EUCI sharing and exchange of classified information

2(d) Where necessary, the Coordination Group may set up ad-hoc sub-groups for a
specific task and for a limited duration.

2.2, Except where otherwise provided in their terms of reference, the sub-groups shall be

l;ascd on open bership rep ing the Union ion or body concemed.
3. The members of the sub-groups shall be experts in the respective field of comp e.

4. The Secretariat of the Coordination Group, referred to in Article 5(5), shall support the
work of all sub-groups and ensure the communication between its members.
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Thematic sub-zroup

1. The Coordination Group shall set up the following permanent thematic sub-groups
to facilitate the implementation of this Regulation:

(2) 2 sub-group on information assurance;

(b) asub-groupon physical secunty;

(c) a sub-group on accreditation of
handling and stoning EUCI;

a sub-group on EUCI sharing and exchange of classified information.

Where necessary, the Coordination Group may set up ad-hoc sub-groups for a
specific task and for a limited duration.

Except where otherwise provided in their terms of reference, the sub-groups shall be
based on open membership representing the Union imstitution or body concerned.

The members of the sub-groups shall be experts in the respective field of competence.

4. The Secretanat of the Coordination Group, referred to in Article 5(3), shall support the
work of all sub-groups and ensure the communication between its members.

Reject a track change in the text
In order to reject a change in the text, the user right clicks on the change and chooses to
reject the change.

0. a @ B I % x %M 5=
EMA Q|| @source B A-

Definitions
For the purpose of this Regulation, the following definitions apply:
(2) ‘mformafion’ mesns swy—all data i oral, wvismal, electronie. magnetic, or

physical form, or in the form of material, equipment or technology and ncludes
reproductions, translations and material in the process of development;

(b)  “information security’ means ensuring the authenticity,
confidentiality, integrity and non-repudiation of information;

(z)  ‘handling’ of information means zl] pesstble-actions to which the information
can be subject throughout its life cycle; (@ Paste CtreV om, collection,
registration, assignment of a comfider zing, display,
consultation, carriage, transmission, dew ion, archiving
and destruction,; @ Reject this change

@ Accept this changs

(d) 'storing’ means the act of keeping information cn any medium to ensure its
availability for fiture use;

(e)  “Union institutions end bodiez” means the Union institutions, bodies, offices and
agencies set up by, or on the basiz of, the Treaty on European Union, the Treaty
on the functioning of European Union, the Treaty establishing the Eurcpean
Atomic Energy Commumity or a legizlative act;

The system will immediately process the action. When the user goes outside the box, the
change is saved.
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Definitions

For the purpose of thiz Regulation, the following definitions apply:

(2) ‘informstion’ means ssy—all data in oral, visual, electromic, magnetic, or
physical form, of in the form of material, equipment or technolegy and includes
reproductions, translations and material in the process of development;

(b} ‘information secunfy’ mesns ensurmg  the  zuthenticrty,
confidentiality, integrity and non-repudiation of information;

() ‘handling” of information mesanz all poszible actions to which the information
can be subject throughout itz life cycle; it comprises itz creation, collection,
registration, assignment of a confidentiality level, processing, display,
consultation, camiage, fansmissicn, downgrading, declassification, archiving
and destruction;

(d) ‘'storing’ means the act of keeping information on any medium fo ensure its
availability for future use;

(e)  ‘Union institutions and bedies’ means the Union institutions, bodies, offices and
agencies set up by, or on the basiz of, the Treatv on European Union, the Treaty
on the fimctioning of Eurepean Union, the Treaty establishing the European
Atomic Energv Community or a legislative act;

Move points inside an article
The user goes at the end of the point and right clicks. The system presents the option to
move the point to a different location.

[2¢} [E] B I x x* % [ == a' B
T M Q| Q| B source (AR

Article 5
Information security risk management process

1. Each Union mstitution and body shall establish an information security risk
management process for the protection of the information they handle and store.

2. The information security risk management process shall include the following steps:

(a)  threat and vulnerability identification;

- -

E Paste Ctri+V

(b)  risk assessment; Move this point to._
(c)  risk treatment:;

(d) risk acceptance:

(e) risk communication.

3. The information security risk management process shall take account of all factors
relevant for the institution or body conecerned, in particular:
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The user clicks ‘Move this point to’ and goes in the place where s/he wants to move the
selected point (in the same article or in another one). The user right clicks and the system

presents the option to ‘Move here as point’.

=» Moving a point inside the same article

[+ .l B « B I x x* A& S= g = a B
T M Q| 4| [ soure n-

Article 5
Information security risk management process

1. Each Union institution and body shall establish an information security risk
management process for the protection of the information they handle and store.

2. The information security risk management process shall include the following steps:
(a) threat and vulnerability identification;
(b)  risk assessment:
(c) risk treatment;

(d)  risk acceptance:

[E Paste
ri
Move here L As point
3. The information security risk management process shall take account of all factors

relevant for the institution or body conecerned, in particular:

The user selects the option ‘move here as point’ and the change is immediately shown in

the text as below.

LEOS v 5.0.3.
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[ 2] B I x x 43 S =| g e | o B
2 M Q)| @ source -

Article 5
Information security risk management process

1. Each Union imstitution and body shall establish an information security risk
management process for the protection of the information they handle and store.

2. The information security risk management process shall include the following steps:

(a) MOVED fo Article 5(2), point (d) RN aant s S e st

risk assessment;

risk treatment;
(c)  risk acceptance:

(RNt RV Wt RN i J€V)  threat and vulnerability identification:

(e) risk communication.

3. The information security risk management process shall take account of all factors
relevant for the institution or body concerned. in particular:

The user goes outside the box and the system tracks the change and renumbers all the
points accordingly.

Article 5
Information security risk management process

1.  Each Union institution and body shall establish an information security risk
management process for the protection of the information they handle and store.

2. The information security risk management process shall include the following steps:

hrestadruhrerabiity rdentifreation:
£59(a) risk assessment;

{=3(b) risk treatment;

eh(c) risk acceptance:

threat and vulnerability identification:

(e) risk communication.

3. The information secwrity risk management process shall take account of all factors
relevant for the institution or body concerned, in particular:

=» Moving a point from an article in a different article
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The system shows in track changes the text moved, shows from where the text was
moved and the new position and renumbers the points accordingly.
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4.

Thematic sub-groups

The Coordination Group shall set up the following permanent thematic sub-groups
to facilitate the implementation of this Regulation:

(a)  asub-group on information assurance;

{b) MOVED to Article 10, first paragraph. point (b) e o e e s

b a sub-group on physical security;

a sub-group on accreditation of communication and information systems
handling and storing EUCT:

d a sub-group on EUCT sharing and exchange of classified information.

Where necessary, the Coordination Group may set up ad-hoc sub-groups for a specific

task and for a limited duration.

Except where otherwise provided in their terms of reference, the sub-groups shall be

based on open membership representing the Union institution or body concerned. The
members of the sub-groups shall be experts in the respective field of competence.

The Secretariat of the Coordination Group, referred to in Article 5(3), shall support the

[15)

work of all sub-groups and ensure the communication between its members.
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Article 10
Sub-group on information assurance

The sub-group on information assurance, as referred to in Article 7(1) point (3), shall have
the following roles and responsibilities:

(a) providing guidance and best practices on the marking, handling and storing of
information in CISs in close cooperation with the Interinstitutional cybersecurity
board referred to in Article 9 of Regulation EU [XXX] laving down measures
for a high common level of cybersecurity at the institutions, bodies, offices and
agencies of the Union;

[P O Sg v Wb (T LUV i) 2 sub-group on non-classified information

establishing a metadata scheme for markings and all necessary technical
information to contribute to an interoperable and seamless exchange of
information across Union institutions and bodies, when interconnecting their
respective CISs;

contributing to the coherence between the information security rules and the
cybersecurity baseline across all Union institutions and bodies, referred to m
Article 5 of Regulation EU [X3(X] laving down measures for a high common
level of cybersecurity at the institutions. bodies, offices and agencies of the

Union| 0

The user goes outside the box and the change is saved.
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Thematic sub-groups

1. The Coordination Group shall =et up the following permanent thematic sub-groups
to facihtate the implementation of this Regulation:

(2)  asub-group on information assurance;

£23(b) a sub-group on phyzical security;

fdicla smb-gronp on seccreditztion of commmmmicsfion and mformation systems
handling and storing EUCT;

fe34(d) a sub-group on EUCT sharing and exchange of classified information.
2. Where necessary, the Coordinzfion Group may zet up ad-hoe sub-groups for 2 specific
tazk and for a limited duration.

3. Except where otherwize provided in their terms of reference, the sub-groups shall be
based on open membership reprezenting the Union institution or body concemed. The
members of the sub-groups shall be experts in the respective fizld of competence.

4. The Secretariat of the Coordination Group, referred fo in Article 5(3), shall support the
work of all sub-groups and ensure the communication between its members.

Article 10
Sub-group on information assurance

The sub-group on information assurance, as referred to in Article 7(1) point (a), shall have
the following roles and responsibilities:

(2) providing gmdance and best practices on the marking, handling znd storing of
information in CIS: i close cooperation with the Interinstitutional
cybersecurity board referred to in Article 9 of Regulation EUT [330X] laying
down measures for a high commeon level of cvbersecurity at the institutions,
bodies, offices and apencies of the Union;

feyc) establishing a metadata scheme for markings and all neceszary technicsl
information to contribute to zn interoperable and seamless exchange of
information across Union institutions and bodies, when intercormecting their
respective CISs:

Change the structure of the points insider the article
The user can change the structure of the points inside an article using indent/outdent
features.

[ | = B I x x % EI%IE 4= | o B

=M Q| 20| o source B -

outdent indent
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The system tracks the changes and renumbers the points accordingly.

Jane Doe : 2024-02-08715:13:04.83+01:00

Themat

1. The Coordination Group shall set up the following permanent thematic sub-groups
to facilitate the implementation of this Regulation:

(a) asub-group on information assurance;
(o)  asub-group on physical security;

() a sub-group on accreditation of communication and information systems
handling and storing EUCI;

1) a sub-group on EUCI sharing and exchange of classified information.

Where necessary, the Coordination Group may set up ad-hoc sub-groups for a
specific task and for a limited duration.

52, Except where otherwise provided in their terms of reference, the sub-groups shall be
based on open membership representing the Union institution or body concemed. The
members of the sub-groups shall be experts in the respective field of competence.

4-3. The Secretariat of the Coordination Group, referred to in Article 5(5), shall support the
work of all sub-groups and ensure the communication between its members.

Split a numbered paragraph
The user puts the cursor in the place s/he wants to split the paragraph (marked below
with the red arrow) and clicks enter. The system tracks the change and renumbers the
paragraphs.
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| Source

Thematic sub-groups

1. The Ceordination Group shall zet up the following permanent thematic sub-groups
to facilitate the implementation of thiz Regulation:

(2]  asub-group on nformation assurance;

(1) MOVED to Article 10, first paragraph, point (b) It ett e e R R

(b) 2 sub-group on physical security;

(c)] a sub-group on accreditation of communication and information systems
handling and storing EUCT;

a sub-group on EUCT sharing and exchange of classified information.

Where necessarv, the Coordination Group may set up ad-hoc sub-groups for a
specific task and for a linuted duration.

based on open membership reprezenting the Union inditution or body concemed. YThe

2. E=zcept where otherwise provided in their terms olEference: the sub-groups shall be
members of the sub-groups shall be experts in the respecti®

field of competence.

3. The Secretariat of the Coordination Group, referred to in Article 3(3), shall support the
work of 2] sub-groups and ensure the communication between itz members.

Once the user goes outside the box, the change is saved.

LEOS v 5.0.3.

Thematie sub-groups

1. The Coordination Group zhall zet up the following permanent thematic sub-groups
to facilitate the implementation of thiz Fegulation:

(2) asub-group on information assurance;
(b}  asub-group on phyzical securty;

() a sub-group on accreditation of communication =nd information zystems
handling and storing EUCT;

£43(1) a sub-group on EUCT sharing and exchange of claszified information.

2(d) Where necessary, the Coordination Group may set up ad-hoe sub-groups for a
gpecific task and for a limited duration.

%2 Except where otherwise provided in their terms of reference, the sub-groups zhall be
based on open membership representing the Union institution o body concemed.

3. | The members of the sub-groups shall be experts in the respective field of competence.

4. The Secretariat of the Coordination Group, referred to in Article 3(3), shzll support the
work of all sub-groups and enzure the communication between itz members.
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Track changes in higher subdivisions
The user can easily change a title of a chapter/section/article clicking once inside the
editable box and adding the new title.

Chapter 3

Information assurance and communication and information /

systems (CISs)

Principles of information aszurance

1. The aszeszsment of the information security needs shall be taken inte account from the
start of the creation or at the procurement stage as regards all CIS: including in-house,
outsourced and hybrid CISs.

2. Any CIS that handles and stores EUCI shall be accredited in accordance with Chapter
5, Section 3. Any CIS that handles and store: sensitive non-classified information shall
comply with the minimum requirements for sensitive non-classified information in CISz set
out in Chapter 4.

When the user leaves the box, the system saves the change.

Chapter 3

Information assurance and communication and information

(CISs)

Prineiples of

1. The aszeszment of the information security needs shall be taken inte account from the
start of the creation or at the procurement stage az regards all CISs including in-house,
cutsourced and hybrid CISs.

2. Any CIS that handles and stores EUCT shall be accredited i accordance with Chapter
3, Section 3. Any CIS that handles and stores sensitive non-classified mformation shall
comply with the minimum requirements for sensifive non-classified information in CISs zet
out in Chapter 4.

Highlight the text
The user selects to edit the text.
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1. Information intended for put =. . . . tion or already disclosed. which
can be shared without restrictions i1 institutions and bodies, shall be
categorised and handled and stored as mformation for public use.

2 Union institutions and bodies may mark with ‘PUBLIC USE’ the information referred

to in paragraph 1.

3. All Union institutions and bodies shall ensure the integrity and availability of
information for public use by appropriate measures based on its security needs.

The user selects the part of the text s/he wants to highlight and picks the colour. Once the
user goes outside the box, the system saves the change automatically.

Article 12
Information for public use

1.  Information intended for public use or official publication or already disclosed. which
can be shared without restrictions inside or outside the Union institutions and bodies, shall be
categorised and handled and stored as information for public use.

2. Union mstrtutions and bodies may mark with ‘PUBLIC USE’ the information referred
to in paragraph 1.

3. I Union institutions and Bodies shall ensure the integrity and availability of

information for public use by appropriate measures based on its security needs.

Collaboration using track changes

In the case when more authors/collaborators do changes in the same document, all the
changes are highlighted with different colours (a different colour is assigned to each user)
and when hoovering on each change, the name of the person and the timestamp are

shown.

Having regard to the Treaty establishing the European-AtomteEnergy-Comfghjfmunity, and =
in particular Article 1664107 thereof,
Jane Doe
O UIC

: 2024-02-08T11:34:42+01:00

Having regard to the propd
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in particular Article 1664107 thereof.

Having regard to the Treaty establishing the Eurepean-Atomie Enerey-Comighjfmunity, and =

Having regard to the proposal from the European Commission.

: 2024-02-02T14:17:34+01:00

Collaboration using comments and suggestions
Comments

The selects the text for which s/he wants to add a general remark and selects to add a
comment. The user types the comment and posts it to collaborators.

(ay) ’classified subcontract’” means a contract entered into by a contractor or
beneficiary of a Union institution or body, with a subcontractor for the supply of
movable or immovable assets, the execution of works or the provision of
services, the perf of which regq! or involves the handling, including
creation, or storing of EUCI;]

(az) ‘Programme or Project Secunty Instruction’ or ‘PSI' means a list of secunity
procedures which are applied to a specific programme or project in order 1o
standardise security procedures;

(ba) ‘Security Aspects Letter’ or ‘SAL’ means a set of special contractual conditions,
1ssued by the contracting or granting authority, which forms an integral part of
any classified contract or grant agreement involving access to or the creation of
EUCI, that identifies the security requirements and those elements of the
contract or grant requiring security protection;

Annotations ! Document Notes

Jane Doe (Organisati
iiart .

The user takes the comment into account and edits the respective text.

beneficiary of a Union institution or body,
supply of movable or immovable assets, the execution of works or the provision
of services, the performance of which requires or mnvolves the handling,

including creation, or storing of EUCT;

(ayv) ‘classified subcontract’ tneans a contract entered into by a contractor or

with—=a he subcontractor for the

Suggestions

The user selects the text s/he wants to modify and selects to add a suggestion. The user
adds a suggestion for the text and posts it to collaborators.

General principles

1.  Each Union institution and body shall be responsible for the impl on of the
provisions of this Regulation within 1ts organisation taking account of its own information
security risk management process.

2.  [Non-compliance] with this Regulation, in particular the unauthorised disclosure of
information with the conf lity levels referred to in Article 2(2), except information for
public use shall be subject to investigation and may trigger personnel hability in accordance
with the Treaties or with their relevant staff rules

3 Union institutions and bodies shall assess all information they handle and store i
order to categorise it in accordance with the confidentiality levels referred to in Article 2(2).

Annotations 1 Document Notes

Jane Doe (Organisation) (16/02/24, 16:53
Non-compliance

HerreompheneeCompliance

i
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When the suggestion is accepted, the suggested text is shown in track changes.

General principles

1. Each Union institution and body shall be responsible for the implementation of the
provisions of this Regulation within its organisation taking account of its own information
security risk management process.

2. with this Regulation, in particular the unauthorised
disclosure of information with the confidentiality levels referred to 1 Article 2(2), except
information for public use shall be subject to investigation and may trigger personnel liability
in accordance with the Treaties or with their relevant staff rules.

Structural changes

Add an element from the navigation pane

To do changes at the document structure level, the user has the option to ‘Edit document
structure inline’ from the navigation pane.

Navigation Pane

i F4 | Edit document structure inline

Preface
> Preamble
“ Enacting Terms
“ Chapter 1 - General provisions
Article 1 - Subject matter This Regulation la...
Article 2 - ScopeUL NEW 1.This Regulation s...
Article 3 - Definitions For the purpose of th...
Article 4 - General principles 1. Each Union...
Article 5 - Information security risk manage...
W Chapter 2 - Governance and organisation of sec...
Article 6 - Interinstitutional Information Sec...
Article 7 - Thematic sub-groups 1. The Coor...
Article 8 - Organisation of security 1. Each ...
“ Chapter 3 - Information assurance and commun...
Article 9 - Principles of information assuran...
Article 10 - Sub-group on infermaticn assu...
Article 11 - Requirements for communicati...

W Chapter 4 - Non-classified information
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The user selects to ‘Edit document structure inline’. The system displays the elements
available for drag and drop in the document, depending on its type. The system will not
allow the user to include elements in the positions where they should not be included.

< Elements
Navigation Pane
i X

Preface

> Preamble

W Enacting Terms

 Chapter 1 - General provisions i

Article 1 - Subject matter This Regulati... :

Article 2 - ScopeUL NEW 1.This Regula...
Article 3 - Definitions For the purpose ...
Article 4 - General principles 1. Each ...
Article 5 - Information security risk ma...

N Chapter 2 - Governance and organisation of...
Article 6 - Interinstitutional Informatio...
Article 7 - Thematic sub-groups 1. The...
Article 8 - Organisation of security 1. E...

“ Chapter 3 - Information assurance and com...
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Elements

Navigation Pane v

i X
Preface
» Preamble
W Enacting Terms
W Chapter 1 - General provisicns i
Article 1 - Subject matter This Regulati... :

Article 2 - ScopeUL NEW 1.This Regula...
Article 3 - Definitions For the purpose ...
Article 4 - General principles 1. Each ..
Article 5 - Information security risk ma...

“ Chapter 2 - Governance and organisation of...
Article 6 - Interinstitutional Informatio...
Article 7 - Thematic sub-groups 1. The...

Article 8 - Organisation of security 1. E...

Chapter cannot be dropped on Preamble

The user adds an article. The system presents an option to include a heading for the article
and to choose between the types regular and definition.

< Elements

Navigation Pane Vv

Re

o O O @ x
W Chapter 1 - General provisions i

Article 1 - Subject matter This Regulati...

Article # - Article heading... Text... :

B on
Article 2 - ScopeUL NEW 1.This Regula...
T
Article has been added successfully! Mo

Delete

Versions >
Change Type » Definition

The user adds a heading and clicks on ‘save and close’ in the navigation pane. The article
added is shown in bold in the navigation pane and in track changes in the document. The
system renumbers the articles accordingly.
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MNavigation Pane

&

W Lnaprer 1 - Leneral provisions
Article 1 - Subject matter This Regulation la...
Article 2 - NEW ARTICLE 1.Text...
Article 3 - ScopeUL NEW 1.This Regulation s...
Article 4 - Definitions For the purpose of th...
Article 5 - General principles 1. Each Union...
Article 6 - Information security risk manage...
“ Chapter 2 - Governance and organisation of sec...
Article 7 - Interinstitutional Information Sec...
Article 8 - Thematic sub-groups 1. The Coor...

Article 9 - Organisation of security 1. Each ...

General provisions

Subject matter

This Regulation lays down information security rules for all Union institutions and bodies.

Remove an element from the navigation pane
The user wants to delete one of the articles using the option ‘Edit document structure
inline’. The user selects the article s/he wants to delete and clicks on the ‘Delete’ option.
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Navigation Pane

i X

Article 2 - NEW ARTICLE 1.Text...

Article 1 - Subject matter This Regulati...

Article 3 - ScopeUL NEW 1.This Regula...

Article 4 - Definitions For the purpose ...

Move

Delete

Change Type »

—

.
-
.

N ANVANVA N )

Section

Article

The system presents a confirmation message and waits for the acknowledgement of the

user.

Delete Element: confirmation

Are you sure you want to delete this element?

The user acknowledges his/her action.

LEOS v 5.0.3.
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< Elements

Navigation Pane

o DO O @ x

Preface
> Preamble
“ Enacting Terms
Article 1 - Scope 1. Text... :
Article 3 - Article heading... 1.Text... :
Article 4 - Definitions Text... :
Article 5 - Entry into force This Regulation ... :

Article 6 - Access to assistance and proble...

Signature

Versions »

- —

Once the user clicks on ‘save and close’ from the navigation pane, the system tracks the
change (removal of the article) in the navigation pane and in the document. The system
renumbers the articles accordingly.

Navigation Pane v

& @
Preface

> Preamble

“ Enacting Terms
Article 1 - Scope 1. Text...
Article 2 - Article heading... 1.Text...
Article 3 - Definitions Text...
Article 4 - Entry into force This Regulation shall ...
Article 5 - Access to assistance and problem-sol...

Signature

Versions >
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Chapter 1

General provisions 4

Article 2

Move an element in the navigation pane
The user selects to move an article. The user selects the article and drops it in the position
s/he wants to move it.

< Elements
Mavigation Pane Citation
Recital
i O O A %
Part
Article 1 - NEW ARTICLE 1.Text... :
Title

Chapter
Article 3 - Definitions For the purpose ...

Section

Article #[¥(03400) - ScopeUL NEW 1.T...

Article
Article 4 - General principles 1. Each ...

The user clicks on ‘save and close’ and the change is tracked in the navigation pane and in
the document.
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Navigation Pane

i 4
Preface

> Preamble

~ Enacting Terms

“ Chapter 1 - General provisions

Article 1 - NEW ARTICLE 1.Text...
(MOVED/
Article 2 - Definitions For the purpose of th...
Article 3[03U3) - ScopeUL NEW 1.This R...
Article 4 - General principles 1. Each Union...
Article 5 - Information security risk manage...
W Chapter 2 - Governance and organisation of sec...

Article 6 - Interinstitutional Information Sec...
Article 7 - Thematic sub-groups 1. The Coor...

Article 8 - Organisation of security 1. Each ...

General provisions

NEWARTICLE

Definitions
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Reject a structural track change
In order to reject a structural change, the user right clicks on the change (article in the
case from below) in the document and chooses to reject the change. The system will then
renumber the articles accordingly.

) Reject this change

) Accep this changs

Chapter 1

General provisions

Definitions

For the purpose of this Regulation, the following definitions apply:

(a) ‘information’ means any-all data in oral, visual, electronic, magnetic. or
physical form, or in the form of material. equipment or technology and includes
reproductions. translations and material in the process of development:

(b) ‘information security’ means ensuring the authenticity, avatabiity:
confidentiality, integrity and non-repudiation of information:

Show track changes

The user has by default the option to see the track changes.
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JaneDoe(Organisal\on)lfl ‘, @

Home > Workspace > Proposal View > Legal Act v0.1.2 - last edited by Jane Doe (Organisation)  04/2024 14:13

Enable track changes
B save 1) Import from O] Exports I Q search See user guidance

@& See track changes

Displa Track-chanees ~

EdiT Drafting JaneDcelngansa:omL‘il LD

fHome > Workspace > Proposal View > Legal Act v0.1.4 - last edited byJane at n 03

Close

B sove 11 Import from O} Exports § Q Search o€ User guid

A

Rp——
Market: more opportunities for people 3ad b

Navigation Pane v

(4) The commmnication of the Coen
Swategy

or Europe’ recoy

wnovation,  growt
s adopted by the E

borders coul

portals, websites, 1

Annotations & document notes

If the user unchecks ‘See track changes’, all the changes in the text are shown as if they
were accepted. If the user checks again ‘See track changes’, the track changes are
displayed again.

Ed|T Draﬁ:ing Jane Doe (Organisation

Home > Workspace > Proposal View > Legal Act v0.1.4 - last edited by J anisation)on 03/04/2024 14:18

Enable track chang

B save

Import from O} Exports Q Search See user guidance

e track changes

Display Track-changes ~

< and businesses. This Regulation is a key clement of the Single Market Strategy ¢
by the of the C: ion of 28 October 2015 entitled

Upgrading the Single Market: more opportunities for people and business’.

Navigation Pane v

=

The communication of the Commission of 6 May 2015 entitled 'A Digital Single Market
Strategy for Europe’ recognised the role of the intemet and digital technologies in
& @ transforming our lives, changing the way in which citizens and businesses access
information. acquire knowledge. buy goods and services. participate in the market and
work. thereby facilitating for vation. growth and jobs. That
> Preamble communication. along with several resolutions adopted by the European Parliament,
acknowledged that the needs of citizens and businesses in their own country and across
borders could be better met by extending and integrating existing European-level
Article 1 - Scope 1. Text. portals, websites, networks, services and systems and by linking them with different
national solutions. thereby creating a single digital gateway serving as a European single
entry point ('the gateway’).

Preface

\V Enacting Terms

Article 2 - Definitions Text

Article 3 - Entry into force This Regulation sh.
(5) The European Parliament and the Council have repeatedly called for a more

and more dly package of inf and assistance to help
Article 5 - Establishment of the single digital citizens and businesses navigate the intemal market and to strengthen and streamline
internal market tools in order to better meet the needs of citizens and businesses in their

Annotations & document notes

Article 4 - Subject matter 1.This Regulation la.

Article 6 - Definitions For the purposes of thi
cross-border activities.

Show clean version

In the Repository browser, the milestones sent for contributions are visibly marked.
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LEOS

Proposal for a REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL on test30042024 CQntribUtion StatUS

Updated on 30/04/2024 4:29 by DEMQ Demo (CNECT) [ Sent for

. contribution

If user who has received the milestone for contribution opens the Document viewer, they
can see in the floating menu the option to <Show clean version>.

Home > Workspace > Proposal View > Legal Act v0.1.0 - last edited by DEMO Demo (CNECT) on 30/04/2024 16:29

Sseuserguidance Enable track changes

| a Save

[Tl Import from OJ Exports # Q Search

Show clean version «

| Disila‘ Track-:hanies

See track changes

When selecting this option, the document with all the changes (in the text and structure)
shown as if they were accepted is displayed in the right side of the screen. The version of
the document with track-changes is displayed on the left side of the screen.

Home > Workspace > Proposal View > Legal Act ¥1.0.0 - last edited by DEMO Demo (CNECT) on 06/05/2024 10:59

(<]
See user guidance e «
B save ) Import from OJ Exparts § Q_ Search - sync panels
See track changes
. v1.0.0 - |ast edited by DEMO Demo
Display Track-changes (CNECT) on 06/05/2024 10:59 ~
< Article 2 Articie 2
Definitions Definitions

Navigation Pane

& @
Preface
> Preamble
W Enacting Terms
Article 1 - Scope 1. Text...
Article 2 - Definitions For the purposes of this R...
Article 3- Article heading...ccess to informa...
Article 4 - Entry into force This Regulation shall ..
Signature

Versions >

Eor the purposes of this Regulation. the followiss definitions apply
2. eoral

red office in a Member State, and who accesses the informatic

ce_or problem-solving services, referred to_in_Atic]
cross-border user” means a user in a situation which is not ¢
mber equence of actions
5, 0f 1o obtain from a competent authori
their rights as referred to in point (a) of Al
Member State authority_or body established at

cedure’ m

I
to be able to

authority” mea

local level with i
and problem-solving services covered by this Re;

data udipg fext or sound. ual or audiovis

Artichehreading=ceess to information not included in

For the purposes of this Regulation, the following definitions apply
citizen of the Union, a natural person residing in a Member State or a

registered office in a Member State, and who accesses the information,
assistance or problem-solving services, referred to In Aricle
gateway: cross-border user” means a user in a sitation which is not ¢
within a single Member State;*procedure’ means a sequence of actions
users to satisfy the requirements, or to obtain from a competent author
to be able to exercise their rights as referred to i poiat (a) of A
authority means any Member State authority or body established a
local level with specific responsibilities relating to the information,

and problem-solving services coverad by this Regulation:*evidence® o
data, including text or sound, visual or audiovisual recording, irresy:
used, required by a competent authority to prove facts or compli
requirements referred to in point (b) of Article 2(2).

Arricle 3

ccess to information not included in Annex T

Annotations & document notes

— e——L .

F = 1008 o 1120 st tha Commissinn mes

VERSIONING

In the Proposal Viewer, within the section ‘Drafts’, you can open the document you want
to view.
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i | EdIT Acceptance Jane Doe (Organisation) c‘ij‘u
Proposal for a REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL on cross border [ scvons 1 | ciose |
Drafts = Milestones  Collaborators Details
Cover Page
Explanatory Memorandum
gal Ac
Financial Statement
Annexes
1
Annex title Last Updated by Last Updated an Actians
Submission form

Once you've opened it, you will be in the Document Viewer. In the left part of the screen,
details on versions of the document will be visible in the 'Versions pane'.

Home > Proposal View > Legal Act v2.0.5 - last edited by Jane Doe (Organisation) on 26/02/2024 14:24 m

B save 11 import from O} Exports Q search

Navigation Pane »

Versions V

Recent changes

Proposal for a
REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL

test 5.0.3

Q

tations & document notes

THE EUROPEAN PARLIAMENT AND THE COUNCIL OF THE EUROPEAN UNION,

Saving versions

There are 3 types of versions when it comes to saving changes:
Technical save (Minor version)

A technical save basically corresponds to an 'autosave' by the system. In practice such
save is done whenever you save changes to an element in the text or automatically when
you click outside the element box. The technical save number will be indicated at the end,
e.g. version 1.2.x.

Technical saves are by default collapsed behind a 'Show modifications' element.
The technical save features:

- the type of action (addition/deletion/edition) and location

- the version

- the technical save creator

The type of change is always shown, and the user becomes visible on mouse over.
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Versions Vv

FIE

Recent changes

1.0.10 Article 4 updated
1.0.9 Article 4 updated
1.0.8 Article 4 updated

10T Articla A sindatad

~ Show less

Save (Major version)

A save is a save explicitly done by the user. It will only save changes in the specific
document you are in (e.g. in the Annex or the Legal Act). When saving, adding a title is
mandatory. The save number will be indicated in the middle, e.g. version 1.x.0.

Save version items features:
- the version
- the major version timestamp and creator

- the major version title and, if any, the description.

Version 0.2.0 - version for the head of
unt

v Show modifications

Create milestone (milestone version)

When creating a milestone of the act/proposal the save number will be indicated on the
left, e.g. version x.0.0.

Creating a major version

Saving a major version means saving changes in the specific document you are in (e.g. in
the Annex or the Legal Act).

In the Document Viewer, click on the <Save > button in the floating menu.

Home > Proposal View > Legal Act v2.0.5 - last edited by Jane Doe (Organisation) on 26/02/2024 14:24 Close

Save I Import from O) Exports } Q search

A

Navigation Pane Vv

& @ Proposal for a

t notes
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Fill in the title, a description (if needed) and click on <Save>.

Save this version

Title *

Description

v
‘ cancel ‘ E

Once saved, the version will be visible in the ‘Versions pane’:

Versions | v

B Q

Recent changes

Version 1.0.0 - For

Interservice Consultation  eymmmmmy ;

Version 0.1.0 - Document created

You will see the version number (e.g. version 1.x.0), timestamp and creator, title and, if
any, the description.

Note

When you save a version of the text in LEOS, the annotations linked to this version are NOT saved. The
save feature applies only to the text.

Version actions

Activate the 'Versions pane’ to the left of the Document Viewer. Next to each milestone,
major or minor saved version, there is the three dots menu:

Version 1.0.0 - For

Interservice Consultation :

g View this version
Revert to this version

v Show more Export this version
Explore the milestone

The three dots menu reveals several actions:
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. View this version: display this particular version in the right panel (no
comparison view).

° Revert to this version: undo all later changes and restore this version of the
text.

° Export this version: export this particular version.

° Explore the milestone: opens the 'Milestone explorer' (available when the

version concerned is a milestone- see Exploring a milestone).

Comparing versions

Activate the 'Versions pane’ to the left of the Document Viewer and click on the compare
icon on the top left.

Navigation Pane >

Versions v
RE
Q

Recent changes

The ‘Versions pane’ will switch to the 'compare mode', which means tick boxes appear
next to the versions.

Tick the versions you want to compare (maximum 2).

At the top of the compare panel, two arrows are added to allow the user to jump to next
or previous change:

Home > Proposal View > Legal Act V20,5 - last ecited by 24 1424
o
stle rack ch . « =
B e T import tror Bpors Q sewrch . - & Bport
« - DAk
< <

Version 2.0,0 - For
Interservice Consuitation

Miestone s

Proposal for a Proposal for & g

REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL E

H

v test 503 on et £03 $

<

Version 1.0.0 - For THE EUROPEAN PARLIAMENT AND THE COUNCIL OF THE EUROPEAN UNION THE EUROPEAN PARLIAMENT AND THE COUNCIL OF THE EUROPEAN UNION g
Interservice Consultation

S 2 Fuoctionan of the Euopean Unico. sed in particular Having regard 10 the Treaty cn the Functioning of the European Union, and in particular ]

Article [ ] thereof

fersion 0.1 ocument created
Version 0.1.0 - Document created Having regard 10 the op

Acting in accordance with the ordinary Jegilative procedute

Whereas
(1) Recaal
) Recw

g of the Funancial Sywem calied

e aimed at suengthensng UaBAparency
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Home > Proposal View > Legal Act v2.0.5 - last edited by Jane Doe (Organisation) on 26/02/.

(%}
. Enable track changes - @ .
Save 1 import from O} Exports £ Q search Sk oier sukdsnce - v = Export 3
""" Buiet |l &) o Sync
See track changes panels
Display Track-changes Comparing 0.0.1 and 2.0.5

Added elements will be marked as green and underlined, removed elements will be
marked as red and with strikethrough:

1.  Text_This article explains the scope of the proposal

Clicking on the <Close> button at the top right, will close the right panel with the other
version of the element and will remove the tick boxes in the ‘Versions pane’.

Download the comparison document

You have the possibility to export in XML the version of the comparison document with
track changes. When you are into a document of the proposal/act (eg. Legal Act), go to
‘Versions pane’ on the left. Under the ‘Version Pane’, click on the comparison icon, then
select which versions of the document to compare.

R

Recent changes

Version 2.0.0 - For

Interservice Consultation Miestone

Version 1.0.0 - Milestone

version created.

Version 0.1.0 - Document created

Then, click on the button at the upper right corner of the screen to export in XML the
comparison document:

Home > Workspace > ProposalView > Legal Act +1.0.0 - last edited by DEMO Demo (CNECT) on 06/05/2024 10:59 lose
(<]
- " A chang « g .
B save [T} Import from O Exports § Q search - e xport
— o0,
Export as PDF file
Display Track-changes Comparing 0.1.0ar R
< | Download XML files ¢
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Downloading a document

The implementation of the export to PDF of a document (the Cover Page, the Explanatory

Memorandum, the Legal Act or each annex individually), with or without annotations, is
not available.

However, it is possible to download a previous version of the document as XML file.

Got to the Versions pane, select the version you want download, click on three dot menu
and select <Export this version>

Home > Workspace > Proposal View > Legal Act

save [T1 Import from OJ Exports }

Navigation Pane >

Versions

@ Q

Recent changes

0.1.4 Article 2 updated

0.1.3 inserted

0.1.2 Import element View this version
alammnme REVErt to this version

Export this version

Downloading a proposal

Users with support role can download a proposal as .leg file from Proposal viewer, click on the
Actions button and select <Download>.

£7% | LEQS Home  support v

DOE Jane \.':i:)ﬁ e

Home > Workspace 3 Proposal View

Proposal for a REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL on test03052024

Close

Drafts  Milestones  Collaborators ~ Details

EXpOrt as POF
Export as Leglswrite
Cover Page Share

Delete

Explanatory Memorandum

Legal Act -
{ )
MILESTONES’ TAB

A milestone is a snapshot of the latest version of the documents of the proposal/act
created by the user. When creating the milestone, adding its title is mandatory. The save
number of each document will be indicated at the beginning, e.g. version x.0.0.
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The version corresponding to a milestone contains:
- the version number,
- the milestone timestamp and creator,

- the milestone title.

Version 2.0.0 - For

Interservice Consultation z .
:

v Show modifications

Creating a milestone

In the Proposal/Act Viewer, click on the tab ‘Milestones’ and then click on <Add> button.

| EdIT Acceptance

Proposal for a REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL on cross border [ sz 1 ] coose |
Orafis | Mideitenes | Colaboraters Detats
[ - Actioe

Choose the type of milestone from the dropdown list and click <Create milestone>. You
can also give a name to the milestone different from the ones in the dropdown list.

Add milestone X

Milestone Type
s For Interservice Consultation v

For Decision
Revision after Interservice Consultation
Other

Title

Cancel Create Milestone

Once saved, the milestone will be visible in the ‘Milestones’ section in the Proposal/Act
Viewer and in the ‘Versions pane’ of each document of the proposal/act.

EdiT Acceptance

Home > Proposal View

Proposal for a REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL on cross border

Drafts | Milestones | Collaborators  Details

Title Date Status Actions

For Interservice Consultation 15/11/2023 11:58 File ready

Exploring a milestone

You can explore a milestone in 2 ways:
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1) Click on the 'Versions pane’, select the milestone you want to check and click on the
three dots on the right of the milestone. Choose <Explore the milestone>.

Version 2.0.0 - For

Interservice Consultation :

View this version
Revert to this version
Export this version
Explore the milestone

2) Go to the Proposal/Act Viewer, click on the ‘Milestones’ tab and check the milestone
you want to explore.

Title Date Status Actions

For Interservica Consultation 24/11/2023 1314 File ready

For Interservice Consultation 24/11/2023 12:52 File ready
View
Send a copy for contribution

Download

By clicking on the three dots in the right corner of the respective milestone, you will have
the possibility to <View> the milestone, to <Send a copy for contribution> and
<Download> the milestone.

After you click on <View>, the 'Milestone Explorer' will open in a pop-up window.

The 'Milestone explorer' will show in read only the version of documents saved within the
milestone:

Milestone Explorer x

Consult parts and annotations included in the milestone - Created on: 02/02/2024 12.53:03by  Jane Doe (Organisation) | Type: For Interservice Consultation Export

Cover Page200]  Explanatory Memorandum : Legal Act 2007 | Financial Statement (1001~ Annex 1 (

Table of Content < Annotations & document notes >

Preface

Proposal fora
Annotations  Document Notes
REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL
on cross border
(Text with EEA relevance)

THE EUROPEAN PARLIAMENT AND THE COUNCIL OF THE EUROPEAN UNION,

It displays:
° milestone metadata (timestamp, user, type)

) the documents with their table of contents and annotations made on the text

Downloading a milestone
You can download a milestone in .leg format.

To do so, select the desired milestone, click on the three dots and select <Download>:
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Drafts Milestones Collaborators Details

Title Date Status Actions

For Interservice Consultation 25/03/2024 14:44 EXPORTED
View
Send a copy for contribution

Download

MANAGING COLLABORATORS

In the Proposal Viewer you see the section 'Collaborators'; there, the author can add or
remove users that will have access rights on the Proposal. These users can work
collaboratively while reviewing and editing the text in the documents.

: | EdiT Acceptance Jane Doe (Organisation) @ ®
Home > proposal View
Proposal for a REGULATION OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL on cross border
Drafts Milestones Collaborators Details
Q Add

Name Entity Role Actions

Managing collaborators (only for authors)

The owner/author of a proposal can choose to share it with other users who can then
view and edit its documents. These users are called collaborators in LEOS.

If you are the author of a proposal, an 'Add' button is available at the top right in the
'Collaborators' tab, to allow you to add users. In front of the ‘Add’ button, there is a
search bar.

To add a ‘contributor’, ‘reviewer’ or other ‘author(s)’ click on the <Add> button. Type the
beginning of the collaborator's name and select the user from the displayed results. As
you can see, we can select the quantity of users that we want to add.

Choose his/her exact role in the drop list next to his/her name. Click on the button <Add
users> to save your choice or press <Cancel> to cancel the operation.

LEOS v 5.0.3. 83



LEOS — User Manual

Add users

Quantity ‘ 1

Name

jand v ] X

|

DOE Jane (DGT)

After saving, the added user(s) will be listed in the 'Collaborators' section of the Proposal
Viewer. The Proposal in question will then be available in the Repository Browser to all the
persons with access rights on the Proposal.

Collaborator roles

To remove an existing contributor/reviewer/author user, click on the three dots menu
(actions) to the right of his/her name and select ‘delete’. The user will be removed from
the list of collaborators of the Proposal and will no longer be able to access it.

If you edit the role of a collaborator, s/he will be able to access the document having the
new rights.

There are 3 roles for collaborators:

Author Contributor Reviewer

Document collaborator roles

Everyone with access to the application can create a document.

Each role grants the user different rights when it comes to the edition of the documents of
the Proposal:

Author Contributor Reviewer

Edit document

Delete document

View document

Restore previous versions

Add milestone

Submit comment

Edit comment

Delete comment
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Create suggestion

Edit suggestion

Accept suggestion

Reject suggestion

< | < <

< L L] L <

Add
author/contributor/reviewer

Remove v
author/contributor/reviewer

Download XML, .leg v

As you can see, only an author can add or remove collaborators.

Collaborating

When you are working in a certain document and other collaborators start editing the

content of the same document, you will receive a notification.

Show r

@®
2
®

CokEdition: Jane Doe started editing this document s content.

If you open a part in which another collaborator is working, you will get the following

notification.

CoEdition detected

ited by following users:

-Jane Doe editing since 11-09-2020 10:28

Changes made in this part might conflict, we invite you to take turns

this part edition.

Click on the user name to launch a Lync chat.

When you click on <Continue>, you will be able to work on the same part simultaneously.
The last save will overwrite any previous changes.

You will see a user icon next to the part, to indicate someone else is editing it. If you hover
over the user icon, you can see the user's name.
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